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ĆWICZENIA NX 8.5

5

 Oprogramowanie, które pomaga zwyciężać

Rozwiązania stosowane w NX, systemie rozwijanym przez koncern Siemens PLM Software, wy-
znaczają standardy rozwoju systemów klasy CAD/CAM/CAE już od bardzo wielu lat. Jednym z po-
wodów dominacji NX na światowym rynku systemów CAx jest nowoczesny modeler CAD, umoż-
liwiający projektowanie dowolnych wyrobów oferowanych na dzisiejszym rynku, bez względu na 
stopień ich złożoności geometrycznej i funkcjonalnej.

Ze względu na swą szeroką funkcjonalność system NX wykorzystywany jest przez największych 
producentów, takich jak GENERAL MOTORS, BOEING oraz SAMSUNG ELECTRONICS. Łatwość 
obsługi NX powoduje, że jest on również doceniany przez tysiące użytkowników tworzących rynek 
małych i średnich przedsiębiorstw.

System NX jest stosowany we wszystkich branżach inżynierii mechanicznej, o  czym świadczą 
wybrane przykłady z branży samochodowej, lotniczej, obronnej, budowy maszyn, marynistycznej, 
produktów konsumenckich, kolejowej oraz innych. 

W ostatnich latach zauważa się też zwiększenie intensywności procesu wymiany konkurencyjnych 
systemów CAD, właśnie na NX, co ma miejsce w firmach o różnej wielkości i charakterystyce pro-
cesów inżynierskich, w tym także wśród dużych światowych producentów. 
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LOTNICTWO I OBRONNOŚĆ 9 z 10 największych światowych producentów

ELEKTRONIKA 4 z 5 największych światowych producentów

AUTOMOTIVE 14 z 15 największych światowych producentów

BR. MASZYNOWA 133 firmy na sumę ponad 750.000 EUR

BR. MEDYCZNA 29 z 30 największych producentów

BOEING +45 000 używanych aplikacji Siemens PLM Software

GENERAL MOTORS +30 000 używanych aplikacji Siemens PLM Software

PROCTER & GAMBLE +60 000 używanych aplikacji Siemens PLM Software

BAXTER +10 000 używanych aplikacji Siemens PLM Software

NISSAN ostatnio wybrał Siemens jako globalną platformę PLM

INTEL ostatnio wybrał Siemens jako globalną platformę PLM

CANON ostatnio wybrał Siemens jako globalną platformę PLM

Szeroka funkcjonalność NX jest szczególnie zauważalna podczas pracy w  specjalistycz-
nych środowiskach projektowych. Są one przeznaczone do wspomagania konstruktorów  
w ściśle określonych segmentach działań inżynierskich, np. podczas projektowania 3D form wtry-
skowych, instalacji rurociągowych czy wyrobów o określonej charakterystyce wizualnej.

Ważną cechą tych środowisk jest wysoki stopień automatyzacji wykonywania zadań konstruk-
cyjnych CAD. Rozwiązania te reprezentują najwyższy poziom również w zakresie wykorzystania 
wiedzy w procesach konstrukcyjnych małych, średnich i dużych zespołów projektowych. Do opi-
sywanych środowisk należą m.in.:

•	 NX Mold Wizard – projektowanie form wtryskowych,
•	 NX Electrode Design – projektowanie elektrod EDM,
•	 NX Progressive Die Wizard – projektowanie tłoczników wielotaktowych,
•	 NX Ship Design – projektowanie okrętów,
•	 NX Shape Studio – modelowanie wyrobów o złożonych kształtach,
•	 NX Human Modeling – projektowanie z uwzględnieniem ergonomii,
•	 NX Routing Mechanical – konstruowanie instalacji rurociągowych,
•	 NX Routing Electrical – projektowanie instalacji elektrycznych.
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O ćwiczeniach

Z myślą o użytkownikach rozpoczynających pracę z systemem NX i poszukujących informacji na 
temat Technologii Synchronicznej przygotowany został niniejszy zbiór ćwiczeń projektowych, pre-
zentujących różne metody modelowania z wykorzystaniem rozwiązań NX. Opracowanie to ma na 
celu przedstawienie szerokiej gamy narzędzi CAD, jakimi dysponuje ten nowoczesny i najbardziej 
kompleksowy system na rynku.

Ćwiczenia projektowe zostały opracowane w formie przewodnika, który krok po kroku przeprowa-
dza użytkownika przez kolejne etapy procesu projektowego. Poszczególnym krokom towarzyszą 
komentarze do wykorzystywanych poleceń i narzędzi, dzięki czemu każde opracowanie skutecz-
nie pełni rolę szkoleniową, łącząc w sobie cechy zwięzłej instrukcji do ćwiczenia i podręcznika CAx. 

Firma GM System zachęca wszystkich do przesyłania propozycji tematyki opracowań, która jest 
szczególnie istotna w kluczowych procesach konstrukcyjnych, technologicznych oraz obliczenio-
wych, realizowanych w przedsiębiorstwach. Najciekawsze tematy zostaną ujęte w kolejnych edy-
cjach opracowań.





Ćwiczenie nr 1:  
MODELOWANIE 3D  

ELEMENTU MASZYNOWEGO
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Ćwiczenie nr 1:  
MODELOWANIE 3D ELEMENTU MASZYNOWEGO 

Pierwsze ćwiczenie poświęcone jest projektowaniu 3D części maszynowej. Modelowanym wyrobem 
jest tuleja przegrody amortyzatora pracującego w warunkach dużych i zmiennych nacisków. Wykonu-
jąc krok po kroku poniższe ćwiczenie, użytkownik pozna szereg narzędzi związanych ze szkicowaniem 
profili 2D i ogólne zasady modelowania bryłowego 3D. Nauczy się również, w jaki sposób wprowadzać 
zmiany bezpośrednio w geometrii modelu z wykorzystaniem poleceń Technologii Synchronicznej. 

Podstawowym zadaniem jest wykonanie modelu 3D stożkowej tulejki amortyzatora olejowo-gazo-
wego, przeznaczonego do pracy w warunkach wysokiej udarności (obraz 1). 

Dla ułatwienia interpretacji kształtu tego komponentu, docelowy model przedstawiono również  
w przekroju 3D (obraz 2). Tworzenie i zastosowanie przedstawionych poniżej przekrojów 3D w NX 
będzie przedstawione w ostatnim etapie ćwiczenia.

Do wykonania ćwiczenia konieczna jest znajomość odgórnie zakładanych wymiarów komponentu 
– niezbędne wymiary przedstawiono na obrazach 3 (kompletna dokumentacja) i 4 (przekrój główny  
w powiększeniu). Na rysunkach celowo ukryto oznaczenia technologiczne tolerancji kształtu i po-
łożenia, pasowań, parametrów chropowatości, etc., pozostawiając jedynie najistotniejsze wymiary 
z wartościami nominalnymi. Przedstawione poniżej kroki pozwalają na wykonanie modelu zgodne-
go z dokumentacją rysunkową.

Obraz 1
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Obraz 2



13Seria wydawnicza CAx dla praktyków

Modelowanie 3D elementu maszynowego

Obraz 3
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Obraz 4



15Seria wydawnicza CAx dla praktyków

Modelowanie 3D elementu maszynowego

•	 Uruchom system NX, następnie wybierz Menu->New.
•	 W oknie dialogowym dokonaj następujących ustawień (obraz 5):

ÔÔ szablon modelowania: pojedyncza część (w obszarze Templates wybierz Model),
ÔÔ ustawienie jednostek: metryczne (Units->Millimeters),
ÔÔwprowadź nazwę tworzonego właśnie pliku NX (.PRT), np. tuleja_przegrody_01.prt,
ÔÔwybierz lokalizację, w której zapiszesz plik (New File Name->Folder),

•	 Wciśnij przycisk OK – zapisany plik NX zostanie otwarty we właściwym środowisku projektowym 
(Modeling).

Obraz 5

	
	

Obraz 5
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System NX posiada wiele różnorodnych środowisk (in. modułów), które zostały zintegrowane  
do postaci jednego spójnego rozwiązania. Moduł Modeling przeznaczony jest do realizacji róż-
norodnych zadań CAD, między innymi tworzenia modeli części oraz złożeń i wykonywania w nich 
pomiarów, analiz, wizualizacji itp. W tym przypadku moduł Modeling umożliwi modelowanie i ana-
lizę geometrii projektowanej tulei.

Z punktu widzenia interfejsu użytkownika modelowanie w NX może się odbywać w dwóch trybach 
ekranu: „normalnym” i tzw. Full Screen (obraz 7). Tryb Full Screen w wielu wypadkach daje więk-
szy komfort pracy poprzez „wygaszenie” nieużywanych w danej chwili elementów ekranu i zamia-
nie wielu pasków poleceń w jeden pasek wstęgowy. Przełączanie pomiędzy trybami dokonuje się 
z wykorzystaniem przycisku Full Screen pokazanego na obrazie 6. 

•	 Aby przełączyć się w tryb pełnoekranowy, wciśnij przycisk Full Screen pokazany na obrazie 6 – 
po przełączeniu trybu Twój ekran powinien być podobny do przedstawionego na obrazie 7.

Obraz 6
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Obraz 7

Modelowanie obiektów osiowosymetrycznych, takich jak projektowana tuleja, opiera się na nary-
sowaniu płaskiego zarysu (półprzekrój) i jego obrocie wokół osi symetrii. Poleceniem umożliwiają-
cym utworzenie „wyciągnięcia obrotowego” jest Revolve. Profil 2D reprezentujący zarys elementu 
może być tworzony w trakcie pracy z poleceniem Revolve lub oddzielnie z wykorzystaniem pole-
ceń Sketch/Direct Sketch. W ćwiczeniu zostanie zaprezentowana metoda druga.

W NX dostępne są dwie podstawowe metody szkicowania: bezpośrednia (szkicowanie na licach/
płaszczyznach z użyciem poleceń z grupy Direct Sketch) i pośrednia z wykorzystaniem polecenia 
Sketch. Zasadnicza różnica polega na tym, że korzystając z polecenia Sketch użytkownik ma dużo 
większe możliwości z punktu widzenia pozycjonowania profilu w przestrzeni, i pracy z układami 
współrzędnych. Sposób drugi zaprezentowano w niniejszym ćwiczeniu.

•	 Upewnij się, że na głównym pasku narzędzi (Toolbar Manager) znajduje się zakładka Direct 
Sketch – jeśli nie, kliknij prawym przyciskiem mysz w dowolnym miejscu paska (z wyjątkiem za-
kładek), następnie włącz opcję Direct Sketch (obraz 8).

•	 Na głównym pasku narzędzi kliknij zakładkę Direct Sketch, aby wyświetlić narzędzia do rysowania 
profili 2D.
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Obraz 8

•	 Wybierz polecenie Sketch (obraz 9), następnie w oknie polecenia zaznacz opcję Intermediate 
Datum CSYS.
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Obraz 9	

•	 Włączenie opcji (Intermediate Datum CSYS) powoduje, że szkic zostanie umieszczony na ukła-
dzie pośrednim – układ ten zachowa orientację istniejącego układu współrzędnych (obraz 11), ale 
będzie od niego zupełnie niezależny.

•	 Kliknij lewym przyciskiem myszy płaszczyznę XZ bazowego układu współrzędnych (obraz 10), 
następnie w oknie polecenia wciśnij OK.  

	
Obraz 10

Obraz 9
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Podczas szkicowania widok może być zorientowany dowolnie. W wielu przypadkach jednak wy-
godnie jest pracować ze szkicem, którego płaszczyzna jest zorientowana równolegle do płaszczy-
zny ekranu (widok prostopadły do płaszczyzny szkicu). Szybki dostęp do poleceń przeznaczonych 
do manipulowania widokiem zapewnia menu podręczne, uruchamiane przez kliknięcie prawego 
przycisku myszy w obszarze ekranu graficznego. Znajduje się tam między innymi polecenie Orient 
View to Sketch (obraz 11), które wyrównuje płaszczyznę szkicu z płaszczyzną ekranu. Opcjonalnie 
polecenie można wywołać, korzystając z tzw. gestów myszy – należy wówczas wcisnąć i przytrzy-
mać prawy przycisk myszy, następnie wykonać myszą szybki ruch w prawo (obraz 12). 

Obraz 11								        Obraz 12

•	 W obszarze ekranu graficznego kliknij prawy przycisk myszy, aby wywołać menu podręczne, na-
stępnie wybierz polecenie Orient View to Sketch.

W przypadku klasycznego modelowania z historią operacji, inteligencja (przewidywalne zachowa-
nie) brył 3D w dużej mierze zależy od wiązań 2D (wymiary, relacje) wprowadzonych na poziomie 
profilu. Sterujące wymiary i relacje 2D (np. połączenia, styczność, wyrównanie w poziomie, rów-
noległość itd.) odbierają odpowiednie stopnie swobody elementom szkicu i pozwalają im w trakcie 
edycji zachowywać się w sposób przewidywalny dla użytkownika. Podczas szkicowania relacje 
i wymiary mogą być wprowadzane automatycznie. Dla celów dydaktycznych automatyczne wy-
miarowanie zostanie wyłączone. 
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•	 Na głównym pasku narzędzi przejdź na zakładkę Direct Sketch1, następnie zlokalizuj przycisk Di-
splay Sketch Constraints1 – jeśli nie jest widoczny, rozciągnij pasek, aby go wyświetlić (obraz 13).

•	 Rozwiń przycisk Show All Constraints, następnie wyłącz (ikona powinna pozostać niepodświe-
tlona) opcję Continuous Auto Dimensioning (obraz 13) – zwróć uwagę, że po wyłączeniu opcji, 
ikona przycisku się zmieniła.

Obraz 13

•	 Uruchom polecenie Profile i postaraj się tak zlokalizować kursor myszy, aby odczyt jego położe-
nia przedstawiał wartości widoczne na obrazie 14 (XC=19, YC=0). Jeżeli zajdzie potrzeba zmniej-
szenia widoku, wywołaj menu podręczne i użyj polecenia Fit.

•	 Zwróć uwagę, iż przed zdefiniowaniem pierwszego punktu linii, polecenie domyślnie pracuje  
w trybie Coordinate Mode, wyświetlając współrzędne X oraz Y.

1 �Przyciski rozwijalne w systemie NX zmieniają swoją ikonę w zależności od ostatnio wybranego polecenia. 

Może się zatem zdarzyć, że obok rozwijalnej strzałki zamiast ikony polecenia Display Sketch Constraints, jest 

wyświetlana ikona jednego z poleceń z listy widocznej na obrazie 13.
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Obraz 14

•	 Kliknij w ustalonej pozycji, aby rozpocząć rysowanie linii – zwróć uwagę, że teraz system przełą-
czył się do trybu Parameter Mode, umożliwiając wprowadzenie długości i kąta dla rysowanego 
odcinka (obraz 15).

•	 Przesuń kursor w prawo do pozycji (6.5, 0). Zauważ, że dokładność wyświetlania wartości długo-
ści jest zależna od aktualnej wielkości obiektów na ekranie. Po ustaleniu właściwego położenia 
kursora kliknij lewym przyciskiem myszy.

Obraz 15
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•	 Skieruj kursor w  górę, tak aby odczyt długości i  kąta wskazywał wartości jak na obrazie 16  
(12, 90) – kliknij, aby utworzyć drugą linię. 

Obraz 16

Obraz 16
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•	 Narysuj kolejno odcinki zgodnie z obrazami 17-21.

Obraz 17

Obraz 20

Obraz 18

Obraz 21

Obraz 19
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W trakcie rysowania system, poza łączeniem odpowiednich końców odcinków, proponuje również 
wprowadzanie innych relacji pomiędzy odcinkami, np. równoległość czy prostopadłość. W sytu-
acji, gdy w danej chwili nie jest to korzystne, możliwe jest zawieszenie rozpoznawania zależności 
przez wciśnięcie i przytrzymanie lewego przycisku ALT.

•	 W trakcie rysowania kolejnego z odcinków (obraz 22), wprowadź wartość długości 80 (po wpro-
wadzeniu kliknij ENTER), ale nie wprowadzaj wartości kąta.

•	 Skieruj kursor w dół i przesuwaj go w lewo i w prawo – zwróć uwagę, że system w pewnym mo-
mencie zaproponuje Ci utworzenie linii równoległej do już istniejącego obiektu (obraz 22). 

Obraz 22
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•	 Po automatycznym rozpoznaniu równoległości kliknij, aby utworzyć linię – zauważ, że system do-
dał do szkicu relację równoległości oraz stworzył wymiar o wartości wprowadzonej w poprzednim 
kroku.

•	 Zamknij profil, tworząc linię, której koniec połączony jest z początkiem pierwszej narysowanej linii 
(obraz 23).

•	 Kliknij dwukrotnie środkowy przycisk myszy (rolkę). Pierwszy raz, aby przerwać rysowanie linii 
i drugi raz, aby zakończyć działanie funkcji Profile.

Obraz 23

W trakcie rysowania profili nie wszystkie relacje mogą zostać wprowadzone automatycznie. Do 
manualnego definiowania zależności geometrycznych przeznaczone jest polecenie Geometric 
Constraints. Dla łatwiejszej analizy szkicu pod kątem wolnych stopni swobody w programie wy-
świetlana jest informacja o ilości brakujących wiązań. Natomiast po włączeniu funkcji nadawania 
wymiarowania wyświetlone zostają niewielkie układy współrzędnych pokazujące kierunki, w któ-
rych elementy szkicu mogą się poruszać.

•	 Na głównym pasku narzędzi przejdź na zakładkę Direct Sketch, następnie wybierz polecenie 
Geometric Constraints (obraz 24).

•	 Zwróć uwagę, że w górnej części okna wyświetlana jest informacja o 11 brakujących wiązaniach.
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Obraz 24

•	 W celu wyrównania ostatniego narysowanego odcinka w pionie, w oknie Geometric Constraints 
zaznacz typ relacji Vertical, a następnie kliknij na linii (obraz 25).

•	 Zauważ, że po zastosowaniu nowej relacji system informuje już o  10 brakujących wiązaniach 
(obraz 26).

Obraz 25
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Obraz 26

•	 Zakończ działanie polecenia Geometric Constraints.
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Więzy geometryczne mogą być również nadawane obiektom szkicu „w locie”, tuż po ich zazna-
czeniu w oknie graficznym. Wykorzystuje się do tego celu kontekstowy pasek narzędzi, który po-
jawia sie automatycznie w pobliżu kursora i zawiera zbiór poleceń zdefiniowanych dla danego typu 
obiektu.

•	 Zaznacz dolną linię profilu oraz oś X układu współrzędnych. W zaznaczaniu osi może pomóc na-
rzędzie QuickPick, które pojawia się, gdy przed kliknięciem na obiekcie zatrzymamy kursor przez 
chwilę nieruchomo, do czasu pojawienia się trzech kropek (obraz 27).

Obraz 27
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•	 Z paska narzędzi wybierz relację Collinear. Zwróć uwagę na efekt wprowadzonej relacji (obraz 28). 
Sprawdź również, czy zmiana ta wpłynęła na zmniejszenie liczby stopni swobody w szkicu.

Obraz 28

•	 Uruchom ponownie polecenie Profile, aby uzupełnić profil o dwa odcinki stanowiące geometrię 
konstrukcyjną.

•	 Rozpocznij rysowanie pierwszego odcinka od kliknięcia w początek prawej pionowej linii profilu 
(obraz 29).

Obraz 29
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•	 Umieść drugi punkt w taki sposób, aby tworzona linia była współliniowa z wyżej położoną pochylo-
ną linią, a jej koniec był wyrównany w poziomie z osią X układu współrzędnych – do tego celu wyko-
rzystaj automatyczne rozpoznawanie zależności lub polecenie Geometric Constraints (obraz 30). 

Obraz 30

•	 Nie przerywając polecenia, dodaj ostatni odcinek profilu, którego koniec będzie pokrywał się  
z końcem pionowego odcinka (obraz 31).

•	 Rozwiń przycisk Continous Auto Domensioning/Display Sketch Constraints i wybierz polece-
nie Convert To/From Reference, następnie zaznacz dwie narysowane przed chwilą linie (obraz 
31) – efekt operacji powinien być zgodny z obrazem 32.

Obraz 31
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Obraz 32

Polecenie Convert To/From Reference przeznaczone jest do konwertowania elementów profilu 
na elementy konstrukcyjne i odwrotnie. W przeciwieństwie do elementów profilu, elementy kon-
strukcyjne pomijane są w procesie tworzenia obiektu 3D. Elementy konstrukcyjne są potrzebne 
w wielu przypadkach, np. mogą stanowić obiekty referencyjne do określenia położenia elementów 
profilu, mogą być też pomocne w procesie wymiarowania. 

•	 Na pasku Direct Sketch rozwiń przycisk Offset Curve2 i wybierz polecenie Mirror Curve (obraz 
33).

2 �Przyciski rozwijalne w systemie NX zmieniają swoją ikonę w zależności od ostatnio wybranego polecenia. 

Może się zatem zdarzyć, że obok rozwijalnej strzałki zamiast ikony polecenia Mirror Curve, jest wyświetlana 

ikona jednego z poleceń z listy widocznej na obrazie 33. 
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Obraz 33

•	 Zaznacz oknem wszystkie narysowane elementy i zaakceptuj wybór, wciskając środkowy przy-
cisk myszy (rolkę). 

•	 Kliknij oś Y jako oś symetrii – profil wraz z elementami konstrukcyjnym zostanie odbity (obraz 34), 
a następnie kliknij OK, aby zatwierdzić zmiany. 

Obraz 34
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•	 Dla obiektów z odbicia symetrycznego (po lewej stronie ww. osi Y) zastosuj polecenie Convert 
To/From Reference, aby zamienić je na geometrię konstrukcyjną (obraz 35). Podczas wyboru 
obiektów możesz użyć możliwości ich zaznaczania prostokątnym obszarem (obraz 36).

Obraz 35			               Obraz 36

Geometria, która jest wynikiem odbicia symetrycznego, zyskuje automatycznie relacje symetrii, co 
zapewnia względną asocjatywność z oryginałem. Polecenie nie odbiera jednak stopni swobody 
elementom profilu, co można zaobserwować również w bieżącym przykładzie (obraz 37). W dalszej 
części ćwiczenia wprowadzone zostaną wymiary sterujące, które pozwolą w  pełni zdefiniować 
szkic i odebrać pozostałe wolne stopnie swobody. 
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Obraz 37

•	 Z paska Direct Sketch, z rozwijalnej listy narzędziowej dla wymiarów (domyślnie przycisk Inferred 
Dimensions), wybierz polecenie Inferrred Dimensions (obraz 38).

Obraz 38
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Istnieją dwa podstawowe sposoby wymiarowania geometrii 2D w NX: bezpośredni wybór konkret-
nego typu wymiaru lub użycie polecenia Inferred Dimensions. Polecenie Inferred Dimensions na 
podstawie zaznaczonych przez użytkownika elementów automatycznie wykrywa i stosuje najbar-
dziej odpowiedni typ wymiaru.

•	 Zaznacz dwa pionowe odcinki po zewnętrznej stronie górnej części tulejki (obraz 39) – zostanie 
utworzony wymiar liniowy o poziomej orientacji, ale nie zostanie jeszcze zdefiniowane jego poło-
żenie.

•	 Przesuń wymiar we wskazane miejsce i kliknij lewym przyciskiem myszy, następnie wpisz wartość: 
27 mm i kliknij ENTER (UWAGA: w tym przypadku, typowe wymiary średnicowe oraz znaki graficzne  
Ø zostały celowo pominięte dla uproszczenia opisywanych tutaj działań CAD).

•	 Zauważ zmianę koloru obiektów, którym odebrany został stopień swobody. Ponownie zbadaj 
liczbę stopni swobody, które posiada obecnie szkic.

Obraz 39

•	 W celu zapoznania się z innymi narzędziami wymiarowymi, z listy wybierz polecenie Horizontal 
Dimension (obraz 40).

•	 Zaznacz dwa pochylone odcinki w pobliżu ich końców, a następnie umieść wymiar zgodnie z ob-
razem 41 i zdefiniuj jego wartość: 19 mm. 
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Obraz 40			               Obraz 41

•	 Za pomocą polecenia Inferred Dimensions wprowadź wymiary dla wewnętrznej szyjki tulejki  
w najwęższym jej miejscu: średnicę 18 mm i wysokość 1 mm (obrazy 42 i 43). Zauważ, że za-
stosowana wcześniej funkcja odbicia lustrzanego zapewnia zachowanie symetrii profilu podczas 
dalszych jego modyfikacji również, gdy zmiany dokonywane są na obiektach skopiowanych. Ob-
serwuj zmieniającą się liczbę stopni swobody w szkicu.

Obraz 42
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Obraz 43

•	 Kontynuując korzystanie z polecenia Inferred Dimensions, zaznacz jeden z pochylonych odcin-
ków w rejonie szyjki tulejki oraz pobliski odcinek poziomy (obraz 44). 

Obraz 44

•	 Zauważ, że program zastosował w tym przypadku wymiar kątowy. Umieść go i zdefiniuj wartość: 45°.
•	 Wykorzystaj narzędzie Inferred Dimensions do zwymiarowania największej średnicy wewnętrznej  

u podstawy tulejki (obraz 45) i nadania jej wartości 38 mm. 
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Obraz 45

•	 Wykorzystując to samo polecenie, dodaj wymiar pomiędzy dwoma pionowymi odcinkami równy 
45 mm (obraz 46), odpowiadający maksymalnej średnicy lica walcowego tulejki. Cały czas zwra-
caj uwagę na zmieniającą się liczbę stopni swobody w układzie.

Obraz 46

•	 Włącz polecenie Horizontal Dimension i dodaj kolejny wymiar (obraz 47), tj. maksymalną odle-
głość ukośnych tworzących stożka, przedłużonych do podstawy – ma ona wynosić 47 mm.
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Obraz 47

•	 Za pomocą polecenia Vertical Dimension wprowadź pionowy wymiar określający całkowitą wy-
sokość profilu, zgodnie z obrazem 48.
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Obraz 48

•	 Zwróć uwagę, że po wstawieniu tego wymiaru komunikat systemu nt. wolnych stopni swobody 
brzmi: „Sketch is fully constrained”, co można przetłumaczyć jako „Szkic jest kompletnie zre-
lacjonowany i zwymiarowany”. Zauważ też, że wszystkie linie szkicu mają teraz kolor oznacza-
jący brak wolnych stopni swobody.
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•	 Wstaw kolejny wymiar pionowy pomiędzy obiektami pokazanymi na obrazie 49.

Obraz 49

•	 Zauważ, że podczas jego wstawiania system wyświetla komunikat o zbyt dużej liczbie zastosowa-
nych wymiarów i więzów geometrycznych. Dodatkowo elementy nadmiarowe zostały oznaczone 
na szkicu kolorem czerwonym (obraz 50).
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Obraz 50

•	 Kliknij prawym przyciskiem myszy na wymiarze p0=80 i z listy wybierz polecenie Convert to Refe-
rence. Spowoduje to zamianę charakteru tego wymiaru, ze sterującego na informacyjny (obraz 51).

•	 Kliknij dwukrotnie na ostatnio wstawianym wymiarze i zmodyfikuj jego wartość na 82 mm (ob-
raz 52). Zauważ, że zmianie uległa wartość zdefiniowanego przed chwilą wymiaru informacyjnego.

Obraz 51		      Obraz 52
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•	 Na pasku Direct Sketch wciśnij przycisk Finish Sketch, aby opuścić środowisko szkicownika.
•	 Na głównym pasku narzędziowym przejdź na zakładkę Feature, a następnie wciśnij przycisk wy-

ciągnięcia obrotowego Revolve (obraz 53).

Obraz 53

W systemie NX istnieje wiele narzędzi ułatwiających zaznaczanie elementów 2D i 3D. W celu przy-
spieszenia zaznaczania wielu elementów 2D profilu, wprowadzono narzędzie o nazwie Selection 
Intent. Narzędzie pozwala z  listy wybrać odpowiednią opcję, która w  momencie wskazywania 
jednego elementu 2D (np. linia) automatycznie zaznacza pozostałe elementy wg. ustalonego kry-
terium. W poniższym kroku ćwiczenia Selection Intent zostanie wykorzystany do szybkiego za-
znaczenia zamkniętego konturu, który posłuży jako profil w  operacji wyciągnięcia obrotowego 
(Revolve).

•	 Kliknij jednokrotnie prawym przyciskiem myszy w wolnym obszarze ekranu graficznego i z listy 
Selection Intent wybierz opcję Region Boundary Curves (obraz 54). 

Obraz 54
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•	 Kliknij w dowolnym miejscu wewnątrz zamkniętego profilu po prawej stronie – zwróć uwagę, że po 
najechaniu kursorem program podświetlił wskazywany obszar (obraz 55).

•	 Zauważ, że zaznaczone zostały wszystkie linie ograniczające wskazany obszar. Dodatkowo pro-
gram wyświetlił wymiary sterujące zaznaczonym profilem, pozwalając na ich ewentualną modyfi-
kację przez wykonaniem wyciągnięcia obrotowego (obraz 56).

Obraz 55				    Obraz 56

•	 Kliknij środkowy przycisk myszy, aby zaakceptować wybór profilu.
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•	 Zaznacz oś Z układu współrzędnych jako oś obrotu – zostanie wyświetlony podgląd bryły obro-
towej, jak na obrazie 57.

Obraz 57

•	 W oknie polecenia kliknij OK, aby zaakceptować wynik operacji. Możesz to również uczynić naci-
skając środkowy przycisk myszy.

•	 Na głównym pasku narzędzi przejdź do zakładki Resource Bar i włącz narzędzie Part Navigator, 
które służy do wyświetlania historii i zarządzania procesem modelowania części (obraz 58).
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Obraz 58

•	 W oknie Part Navigator kliknij prawym przyciskiem myszy na operacji Revolve, następnie wy-
bierz polecenie Hide – ukryjesz tym samym szybko obiekt bryłowy 3D (obrazy 59).

Obraz 59
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•	 Na głównym pasku narzędzi z  zakładki Direct Sketch wybierz polecenie Sketch, a następnie 
zaznacz płaszczyznę XZ i zatwierdź, klikając środowy przycisk myszy (obraz 60).

Obraz 60

•	 Na pasku narzędziowym Direct Sketch wybierz polecenie Project Curve (obraz 61).

Obraz 61
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•	 Wywołaj znane już Tobie narzędzie Selection Intent i wybierz opcję Single Curve (obraz 62).

Obraz 62

•	 Skopiuj (kliknij kolejno, aby rzutować) do szkicu dwa odcinki z profilu pierwszej operacji zgodnie  
z obrazem 63 i zatwierdź operację środkowym przyciskiem myszy. 

Obraz 63
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•	 Ukryj szkic pierwszej operacji – kliknij na jednym z elementów tego szkicu i z podręcznego paska 
narzędzi wybierz polecenie Hide (obraz 64).

Obraz 64

•	 Na pasku Direct Sketch wybierz polecenie Make Corner.

Polecenie Make Corner to niezwykle wydajne narzędzie wspomagające rysowanie 2D. Przezna-
czone jest do szybkiego tworzenia naroży 2D. W odróżnieniu od polecenia Quick Trim pozwala 
nie tylko odcinać niepotrzebne fragmenty przecinających się linii, ale również utworzyć naroże 
z dwóch linii niepołączonych ze sobą, ale posiadających wirtualny punkt przecięcia.

•	 Wciśnij lewy przycisk myszy i przytrzymując go „przejedź” po dwóch odcinkach od góry do 
dołu (pomarańczowa krzywa), jak pokazano na obrazie 65 (po wewnętrznej części tworzonego 
naroża). 

•	 Kliknij OK w oknie informującym o usunięciu parametrów (powiązania z oryginałem) zrzutowanych 
krzywych.
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Obraz 65

•	 W oknie polecenia Make Corner kliknij Close, aby je opuścić. 

Zauważ, że stworzony właśnie fragment profilu został automatycznie zwymiarowany. Wynika to 
z faktu, że w tym szkicu nie została wyłączona funkcja Continuous Auto Dimensioning, jak to 
miało miejsce w  przypadku pierwszego szkicu. Widoczne na ekranie wymiary automatyczne 
generowane są przez system w taki sposób, aby odebrać elementom szkicu wszystkie stopnie 
swobody (obraz 66). Należy jednak pamiętać, że nie są one wymiarami sterującymi, czyli na-
dal możliwe jest swobodne przemieszczanie poszczególnych elementów szkicu. Dopiero zamiana 
tych wymiarów na sterujące lub nadanie dodatkowych więzów geometrycznych zapewnia pełne 
zdefiniowanie stworzonego profilu.
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Obraz 66

•	 Zaznacz dłuższy z odcinków i  z podręcznego paska narzędzi wybierz relację Fully Fixed, aby 
odebrać mu wszystkie stopnie swobody (obraz 67).

Obraz 67

•	 Zaznacz dwa pozostałe wymiary automatyczne, a następnie na podręcznym pasku narzędzi kliknij 
funkcję Convert to Driving, aby zamienić je na sterujące (obraz 68).
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Obraz 68

W ten sposób szkicowi zostały odebrane wszystkie stopnie swobody – na pasku informacyjnym 
pojawił się napis Sketch is fully constrained.

•	 Z paska narzędzi Direct Sketch wybierz polecenie Line i  narysuj odcinek o długości 15 mm, 
prostopadły do dłuższego z istniejących odcinków (obraz 69). 

Obraz 69

•	 Naciśnij środkowy przycisk myszy, aby zakończyć działanie funkcji Line.
•	 Zamień wymiar automatyczny o wartości 15 mm na wymiar sterujący.
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•	 Z  paska Direct Sketch wybierz funkcję wymiarowania Perpendicular Dimension i  zwymiaruj 
odległość prostopadłego odcinka od dolnego punktu końcowego najdłuższego odcinka (obraz 
70). Wpisz wartość nowego wymiaru 70 mm. 

Obraz 70

•	 Z listy, którą wcześniej wykorzystałeś do wyboru polecenia Mirror Curve, wybierz narzędzie słu-
żące do tworzenia odsunięć: Offset Curve (obraz 71).

Obraz 71

•	 Ustaw opcje w oknie polecenia zgodnie z obrazem 72 (upewnij się, że opcje zaznaczone na czer-
wono są wyłączone).

•	 Zmień sposób zaznaczania krzywych, klikając prawym przyciskiem myszy w oknie graficznym  
i wybierając opcję Single Curve (obraz 72).
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Obraz 72

•	 Kliknij krótszą linię (15 mm), aby utworzyć kolejne dwie, odsunięte od niej co 22,5 mm. Odsunięte 
linie powinny wyglądać, jak na obrazie 73 – jeśli są odsunięte w górę, kliknij przycisk Reverse 
Direction, aby ustawić je zgodnie z ilustracją.
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Obraz 73

•	 Kliknij OK, aby dokończyć operację – zwróć uwagę, że system automatycznie wprowadził odpo-
wiednie wymiary (obraz 74).



57Seria wydawnicza CAx dla praktyków

Modelowanie 3D elementu maszynowego

Obraz 74

•	 Wyjdź ze szkicownika, wybierając Finish Sketch.
•	 Wykorzystując tę samą metodę, jak w przypadku ukrywania obiektu, pokaż model bryłowy (Part 

Navigator->Revolve->Show).

W kilku poprzednich krokach wykonany został szkic, który będzie pomocą do wykonania otworów  
w tulei. W dalszej części ćwiczenia pokazano tok postępowania w przypadku tworzenia otworów 
na licach niepłaskich, gdzie do ich pozycjonowania wykorzystywane są dodatkowe płaszczyzny, 
szkice oraz układy współrzędnych.

•	 Na głównym pasku narzędzi przejdź do zakładki Feature, następnie wybierz polecenie Datum 
Plane (obraz 75). 

Obraz 75
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•	 Zwróć uwagę, że w oknie dialogowym spośród bardzo wielu trybów działania polecenia (rozwiń 
listę Type), domyślny tryb to Inferred (wybór automatyczny). 

•	 Upewnij się, że opcje w  oknie dialogowym są identyczne do przedstawionych na obrazie 76 
i wskaż zewnętrzne lico stożkowe tulejki, a następnie długą linię szkicu (zaznaczona na czer-
wono), aby właściwie zlokalizować tworzoną płaszczyznę.

Obraz 76

•	 Kliknij OK, aby zakończyć polecenie.
•	 Wykorzystując poznane wcześniej gesty myszy lub menu podręczne, przełącz się do widoku kra-

wędziowego Static Wireframe (obraz 77).
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Obraz 77

•	 Z głównego paska narzędzi, z zakładki Feature wybierz polecenie Hole, następnie dokonaj usta-
wień w oknie polecenia zgodnie z obrazem 78 (Diameter = 8 mm; Depth Limit = Value; Depth 
= 5 mm).
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Obraz 78

•	 Po dokonaniu ustawień kliknij na polu Specify Point w grupie Position.
•	 Kliknij na „prawym” końcu najniższego z  odsuniętych odcinków szkicu wchodzących w  skład 

drugiego szkicu, zgodnie z obrazem 79. 

Obraz 79
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•	 W oknie polecenia kliknij OK, aby zakończyć tworzenie otworu – efekt powinien być taki, jak na 
obrazie 80.

Obraz 80

•	 Zwróć uwagę na okno Part Navigator i zapoznaj się z możliwościami pokazywania i ukrywania 
elementów – zaznaczaj wybrane operacje (Feature), szkice (Sketch) i płaszczyznę (Datum Plane)  
i wykorzystując menu podręczne, spróbuj je ukrywać i ponownie wyświetlać.

W systemie NX do tworzenia operacji, między innymi otworów, wykorzystuje się dwa typy układów 
współrzędnych (obraz 81):
•	 roboczy układ współrzędnych WCS (Work Coordinate System),
•	 lokalny układ współrzędnych (Datum Coordinate System).

Najważniejsze cechy poszczególnych układów, to:
a) WCS:

ÔÔwizualnie reprezentowany przez wyraźne, kolorowe i pogrubione osie, 
ÔÔdomyślnie nie występuje w Part Navigator,
ÔÔ jeżeli nie jest widoczny, można go pokazać wciskając na klawiaturze przycisk W lub wybierając 
menu Format->WCS->Display,
ÔÔpołożenie WCS może być zmieniane w dowolnej chwili bez wpływu na inne obiekty,
ÔÔwystępuje tylko jeden WCS,
ÔÔprzeznaczony m.in. do pozycjonowania innych obiektów (np. układów Datum CSYS) i ustalania 
kierunków w operacjach.
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b) Datum Coordinate System:
ÔÔwizualnie reprezentowany przez trzy osie i płaszczyzny,
ÔÔpierwszy bazowy występuje w Part Navigator jako Datum Coordinate System (0), 
ÔÔ jeżeli jest ukryty, można go pokazać poprzez zaznaczenie w Part Navigator i wybór polecenia 
Show,
ÔÔ zmiana położenia zależna jest od sposobu utworzenia, może być asocjatywny względem innych 
obiektów lub nie,
ÔÔ istnieje możliwość wprowadzenia dowolnej ilości układów Datum CSYS,
ÔÔprzeznaczony głównie jako baza do wykonywania operacji.

Obraz 81

•	 Jeśli WCS nie jest widoczny, kliknij W, aby go pokazać.
•	 Ukryj Datum Coordinate System (0) (Part Navigator->Hide) – w położeniu bazowym pozostanie 

jedynie WCS. 
•	 Kliknij dwa razy lewym przyciskiem myszy na jego wybranej osi – WCS przejdzie w tryb zmiany 

położenia. 
•	 Kliknij na „prawym” końcu środkowego odcinka drugiego szkicu, jak pokazano na obrazie 82 –

WCS zmieni współrzędne swojego początku z domyślnych [0,0,0] na współrzędne tego punktu, 
czego efekt przedstawia obraz 83.
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Obraz 82			           Obraz 83

•	 Kliiknij oś Z WCS, a następnie ww. odcinek (obraz 84) – efekt zmiany przedstawiono na obrazie 85.

Obraz 84				             Obraz 85
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•	 Kliknij środkowy przycisk myszy (rolka), aby zatwierdzić zmiany.
•	 Wykorzystując menu podręczne lub gesty myszy, zmień rodzaj widoku na cieniowany z krawę-

dziami („Shaded with Edges”), aby model prezentował się jak na obrazie 86.

Obraz 86

Pomimo, że pozycjonowanie Datum CSYS może się odbywać na wiele sposobów, wielu doświad-
czonych użytkowników NX stosuje w tym celu układ WCS. WCS wykorzystuje tzw. uchwyty, dzięki 
którym zmiana orientacji układu jest szybka i intuicyjna (technika przeciągnij i upuść). W dalszej 
części ćwiczenia przedstawiono najważniejsze możliwości manipulacji układem WCS, wykorzy-
stując go jako referencję do zorientowania nowego układu Datum CSYS.

•	 Na głównym pasku narzędziowym, z zakładki Feature wybierz polecenie Datum CSYS (obraz 87).



65Seria wydawnicza CAx dla praktyków

Modelowanie 3D elementu maszynowego

Obraz 87

•	 W oknie polecenia dokonaj ustawień jak na obrazie 88 – zwróć też uwagę na możliwość ponow-
nego wykorzystania narzędzi z grupy Inferred (lista rozwijalna Type). Nie klikaj OK.

Obraz 88

•	 Kliknij dwukrotnie na osi Z układu Datum CSYS/WCS.
•	 Zauważ, że układ zmienił zwrot osi Z (obraz 89).
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Obraz 89

•	 Aby obrócić tworzony układ względem osi Z o 90° w kierunku odwrotnym do ruch wskazówek 
zegara, chwyć (kliknij i przytrzymaj) uchwyt na łuku zbudowanym pomiędzy osiami Y i X 
układu i rozpocznij obrót w ww. kierunku (obraz 90). Efekt widoczny jest na obrazie 91.

•	 Zauważ, że jest możliwe wpisanie wartości konkretnego obrotu (Angle), a także określenie skoku 
dla obrotu manualnego (Snap).

 

 

Obraz 90			               Obraz 91
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•	 Kliknij OK, aby zaakceptować orientację nowego układu.
•	 Ukryj WCS, klikając klawisz W.
•	 Wykorzystując Part Navigator, ukryj płaszczyznę (Datum Plane), którą wykorzystywałeś do 

wstawienia pierwszego otworu.
•	 Wybierz polecenie Hole, następnie w oknie polecenia w grupie Position wciśnij przycisk Sketch 

Section – w odróżnieniu od poprzednio zastosowanej metody, tym razem wstawisz otwór z wy-
korzystaniem szkicownika (obraz 92). 

Obraz 92

•	 Upewnij się, że opcje w oknie polecenia są zgodne z pokazanymi na obrazie 93.
•	 Wskaż płaszczyznę XY ostatnio utworzonego układu współrzędnych jako płaszczyznę szkicowa-

nia, następnie wciśnij OK, aby wejść do szkicu (obraz 93).

Obraz 93

•	 Jeśli nie jest włączona funkcja Sketch Point, przejdź na zakładkę Sketch Tools i wybierz Point.
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•	 Kliknij w początek układu współrzędnych, aby wstawić punkt – chcąc mieć pewność dotyczącą 
dokładnego położenia punktu, możesz wykorzystać znane już narzędzie QuickPick (obraz 94). 

Obraz 94

•	 Wyjdź ze szkicownika (zakładka Sketch->Finish Sketch).
•	 Upewnij się, że opcje otworu odpowiadają opcjom na obrazie 95 (okno dialogowe) i wciśnij OK. 

Obraz 95
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•	 Wciśnij i przytrzymaj klawisze CTRL i W, aby uruchomić polecenie Show and Hide (polecenie 
dostępne też na zakładce Utility na pasku głównym).

•	 W  oknie Show and Hide przy pozycji Coordinate Systems kliknij przycisk z  symbolem „−” 
i zwróć uwagę, że ukryte zostały wszystkie układy Datum CSYS (obraz 96).

Obraz 96

•	 Pokaż układ WCS (klawisz W).
•	 Włącz widok krawędziowy – Static Wireframe (np. gestem myszy).
•	 Wykorzystując poznane wcześniej techniki, przenieś WCS w  miejsce pokazane na obrazie 97 

(upewnij się że oś Z jest wyrównana z „krótką” linią szkicu), następnie wstaw pokrywający się 
z WCS nowy układ Datum CSYS (obraz 98).

Obraz 98
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•	 Stosując drugą z poznanych metod, wstaw nowy otwór (Hole) na wskazanej płaszczyźnie (XY) 
nowego Datum CSYS – ustal parametry zgodnie z ilustracją (obraz 99). 

Obraz 99

W przypadku powtarzających się elementów geometrii nie ma sensu tworzyć kolejnych identycz-
nych operacji. Operacje czy też lica będące fragmentami geometrii mogą być powielane w róż-
ny sposób. System NX oferuje wiele narzędzi umożliwiających powielanie geometrii, tj. tworzenia 
kopii geometrii, kopii lustrzanych czy szyków. Do powielenia otworów tulei w ćwiczeniu zostanie 
wykorzystane polecenie Pattern Feature.
•	  Korzystając z okna Part Navigator, pokaż bazowy układ Datum Coordinate System (0).
•	  Na pasku narzędzi przejdź na zakładkę Feature i wybierz polecenie Pattern Feature (obraz 100).

Obraz 100

•	 W oknie dialogowym funkcji Pattern Feature, w zakładce Pattern Definition, z listy rozwijalnej 
Layout wybierz opcję Circular (szyk kołowy). 

•	 Zdefiniuj parametry szyku, tj. liczbę wystąpień (6) oraz kąt rozmieszczenia (360), a następnie kliknij 
w zakładce Rotation Axis na pozycji Specify Vector i zaznacz oś Z układu współrzędnych (obraz 101).
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Obraz 101

•	 Zaznacz dwa dolne otwory. Po pojawieniu się na podglądzie punktów określających położenie 
kolejnych wystąpień szyku, kliknij OK, aby uzyskać efekt jak na obrazie 103.
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Obraz 102				               Obraz 103

•	 Na pasku głównym przejdź na zakładkę Modeling.
•	 W zakładce Modeling rozwiń przycisk Extract Body i wybierz Mirror Feature (obraz 104).

Obraz 104

•	 Kliknij w górny otwór Ø 5 (obraz 105), następnie kliknij środkowym klawiszem myszy (rolka), aby 
przejść do kroku wyboru płaszczyzny odbicia.

Obraz 104
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Obraz 105

•	 Zaznacz płaszczyznę YZ bazowego układu współrzędnych jako płaszczyznę symetrii dla tego 
elementu, następnie wciśnij OK (obraz 106).

Obraz 106

•	 Powróć do widoku cieniowanego z krawędziami (Shaded with Edges).
•	 W oknie graficznym wywołaj menu podręczne, następnie wybierz Orient View->TOP, aby prze-

analizować geometrię tulei w widoku z góry (obraz 107). 
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Obraz 107

•	 Wciśnij i przytrzymaj środkowy przycisk myszy, następnie poruszaj myszą tak, aby uzyskać 
widok modelu zbliżony do przedstawionego na obrazie 108.

•	 Na pasku głównym z zakładki Feature wybierz polecenie Chamfer służące do fazowania krawędzi. 

Obraz 108
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•	 Wprowadź wartość fazy jak na obrazie 109 i zaznacz zewnętrzną krawędź podstawy tulejki. Efekt 
przedstawiono na obrazie 110.

Obraz 109

Obraz 110
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•	 Korzystając z  tego samego paska narzędzi, wybierz polecenie Edge Blend, przeznaczone do 
tworzenia różnego rodzaju zaokrągleń. 

•	 Ustal wartość promienia (2 mm) i zaznacz wewnętrzną i zewnętrzną krawędź, jak pokazano na 
obrazie 111. Przyciskiem OK zatwierdź wprowadzane zmiany. 

Obraz 111

Ostatnia faza modelowania tulei amortyzatora celowo zakłada wprowadzenie nieprzewidzianej 
zmiany, tj. zwiększenie wysokości walcowej podstawy, zawierającej fazowaną krawędź. 

Klasycznym sposobem takiej modyfikacji byłaby edycja odpowiedniej operacji (Feature) na drze-
wie (Part Navigator) i przebudowa geometrii całego modelu. Można sobie jednak wyobrazić, jak 
trudne może być odszukanie odpowiedniej operacji w  sytuacji, gdy model jest skomplikowany 
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(duża ilość operacji na drzewie), a  wprowadzający zmianę nie jest autorem projektu. Wówczas 
przeprowadzenie analizy powiązań pomiędzy operacjami (Parent-Child relationships) staje się 
czasochłonne, a dowolne zmiany z punktu widzenia konstrukcji drzewa operacji mogą doprowa-
dzić do błędów geometrii. Doskonałym rozwiązaniem w takiej sytuacji jest brak bezpośrednia edy-
cja modelu z wykorzystaniem narzędzi Technologii Synchronicznej.

Polecenia z grupy Synchronous Technology umożliwiają użytkownikom NX wykonywanie bez-
pośrednich modyfikacji geometrii modelu bez ingerencji w drzewo operacji. Oznacza to, że zmiany 
można wprowadzać nie tylko w modelach natywnych (utworzonych w NX), ale również w mode-
lach importowanych z innych systemów. Jest to niewątpliwie jedna z największych zalet NX, 
dająca użytkownikowi swobodę i pełną niezależność w odniesieniu do projektów, w których należy 
przeprowadzać zmiany na dowolnym etapie ich cyklu życia. 

Polecenie Move Face z grupy Synchronous Technology zostanie w ćwiczeniu wykorzystane do 
zmiany wysokości omawianego wcześniej walcowego fragmentu geometrii tulei. 

•	 Na głównym pasku narzędziowym przejdź na zakładkę Synchronous Technology – włącz ją, jeśli 
została ukryta.

•	 Wybierz polecenie Move Face, w oknie polecenia ustaw opcję Transform->Motion na wartość 
Distance i zaznacz 2 lica zgodnie z obrazem 112 (wyróżnione na pomarańczowo).

Obraz 112
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•	 Zwróć uwagę na narzędzie OrientXpress, wyświetlane w tym momencie w formie trzech or-
togonalnych osi układu (wynika z ustawienia Distance), z których jedna (równoległa do Z ba-
zowego układu Datum CSYS) jest wyróżniona – wyróżniona oś definiuje kierunek zmiany  
i  pełni jednocześnie rolę uchwytu, który można wykorzystać do zmian techniką przeciągnij 
i upuść (obraz 113). 

Obraz 113

Obraz 114
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•	 Skieruj kursor na wyróżnioną krótką oś narzędzia OrientXpress i po pojawieniu się znacznika 
kierunku (obraz 113) chwyć tę oś (kliknij i przytrzymaj), następnie przeciągaj ją w lewo do mo-
mentu ustalenia dystansu 6 mm (obraz 114). 

•	 Zatwierdź zmianę, wciskając OK lub rolkę myszy.
•	 Kliknij klawisze CTRL i W, następnie kliknij przyciski „−” przy pozycjach Sketches i Datums – 

ukryjesz w ten sposób odpowiednio wszystkie szkice oraz układy i płaszczyzny (obraz 115). Kliknij 
Close w celu zamknięcia okna.

Obraz 115

W przypadku modeli 3D wyrobów o skompikowanej geometrii, często pojawia się konieczność 
zapoznania się z jej szczegółami. NX do tego celu oferuje swoim użytkownikom wiele narzędzi – 
jednym z nich jest polecenie Edit Work Section, pozwalające na wykonanie przekroju w bryle 3D. 

Za pomocą tego polecenia, w ostatnim etapie ćwiczenia, wykonane zostaną wybrane przekroje 
modelu, w celu stwierdzenia poprawności zaprojektowanej tulei.
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•	 Na głównym pasku narzędziowym włącz zakładkę View, a na niej wciśnij przycisk Edit Work Sec-
tion – wyświetlony zostanie przekrój tulei przy domyślnych ustawieniach polecenia (obraz 116).

Obraz 116

•	 Korzystając z opcji Section Plane oraz 2D Viewer Settings, postaraj się wykonać samodzielnie 
przekrój przedstawiony na obrazie 117. 
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Obraz 117
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Utworzyłeś w systemie NX model tulei przegrody amortyzatora przepływowego (obraz 118). Wyko-
nując ćwiczenie, poznałeś m.in. podstawy tworzenia płaszczyzn i układów współrzędnych, metody 
tworzenia szkiców (profili) oraz podstawowe operacje modelowania bryłowego. Zaznajomiłeś się 
również z metodą wprowadzania bezpośrednich zmian w geometrii z wykorzystaniem Technologii 
Synchronicznej oraz wyświetlaniem przekrojów w modelu 3D.
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Obraz 118
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Ćwiczenie nr 2:  
SYNCHRONICZNE MODELOWANIE SWOBODNE 

Niniejsze ćwiczenie dotyczy zagadnienia modelowania swobodnego z wykorzystaniem zaawan-
sowanych narzędzi Technologii Synchronicznej. Podczas wykonywania ćwiczenia, użytkownik 
zastosuje polecenia umożliwiające swobodną modyfikację kształtu brył i utworzy model, którego 
geometria będzie stosunkowo skomplikowana. 

Zadanie polega na wykonaniu trójwymiarowego modelu obudowy aparatu fotograficznego (ob-
raz 1), której geometria będzie spełniać wymagania zarówno pod względem ergonomii, jak i este-
tyki kształtu. Celowo nie określono wytycznych, co do dokładnych wymiarów obudowy. Projek-
towany wyrób ma zostać zamodelowany jako obiekt bryłowy, a jego geometria ma być poddana 
edycji z wykorzystaniem łatwych w użyciu poleceń do edycji powierzchni. Przedstawione poniżej 
kroki pozwalają na poprawne wykonanie modelu zgodnie z powyższymi założeniami.

Obraz 1	
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•	 Uruchom system NX, następnie wybierz File->New.
•	 W oknie dialogowym dokonaj następujących ustawień:

ÔÔ szablon modelowania: pojedyncza część (w obszarze Templates wybierz Model),
ÔÔ ustawienie jednostek: metryczne (Units->Millimeters),
ÔÔwprowadź nazwę tworzonego właśnie pliku NX (.PRT), np. obudowa_aparatu_01.prt,
ÔÔwybierz lokalizację, w której zapiszesz plik (New File Name->Folder),

•	 Wciśnij przycisk OK – zapisany plik NX zostanie otwarty we właściwym środowisku projektowym 
(Modeling).

Jak wspomniano już w ćwiczeniu pierwszym, system NX posiada wiele różnorodnych środowisk 
(in. modułów), które zostały zintegrowane w jedno spójne rozwiązanie. Moduł Modeling przezna-
czony jest do realizacji różnorodnych zadań CAD, między innymi tworzenia modeli części oraz 
złożeń i wykonywania w nich pomiarów, analiz, wizualizacji itp. Jednym ze sposobów tworzenia 
tzw. bryły podstawowej jest wstawianie tzw. prymitywów (prostopadłościan, walec, kula, stożek 
itd.) o zadanych parametrach. 

•	 Modelowanie rozpocznij od wstawienia prostego prostopadłościanu – w  tym celu wybierz  
Insert->Design Feature->Block.

•	 W oknie polecenia ustaw parametry prostopadłościanu (135x30x78) zgodnie z obrazem 2, na-
stępnie wciśnij OK.

Obraz 2
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W  dalszej części ćwiczenia zaprezentowano narzędzia dostępne w  pakiecie Freeform Shape, 
umożliwiające swobodną zmianę kształtu np. zmianę standardowych lic płaskich (lub innych) 
w dowolne lica niepłaskie. Należy pamiętać, że opisywane narzędzia mogą być stosowane rów-
nież dla zaimportowanych obiektów, które nie posiadają żadnej historii modelowania. Oznacza 
to, że możliwe jest wprowadzanie żądanych zmian w odniesieniu do dowolnych modeli CAD, bez 
względu na sposób ich tworzenia oraz źródło pochodzenia.

Polecenie X-Form (menu Edit->Surface), umożliwi zamianę górnego lica płaskiego wstawione-
go prostopadłościanu na lico swobodne. Lico, które było uprzednio definiowane płaszczyzną po 
zaznaczeniu i  ustaleniu parametrów modyfikacji (obraz 3), definiowane będzie przez swobodną 
powierzchnię z określoną liczbą punktów charakterystycznych (biegunów), połączonych siecią or-
togonalnych krzywych (w chwili początkowej są fragmentami prostej). Pojedyncze punkty, grupy 
punktów lub całe krzywe (wraz z punktami na nich leżącymi) mogą być przemieszczane w dowol-
nym kierunku o żądaną wartość. 

•	 Wybierz Edit->Surface->X-Form.
•	 Zaznacz górne lico prostopadłościanu (obraz 3) – pomoże Ci w  tym narzędzie QuickPick (po 

wyświetleniu „3 kropek” obok kursora, kliknij lewym przyciskiem myszy).

Obraz 3
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•	 Zgodnie z obrazem 4 ustaw parametry polecenia, następnie zaznacz dwie krzywe (z wciśniętym 
przyciskiem Ctrl). 

Obraz 4

•	 Skieruj kursor na jedną z zaznaczonych krzywych (nie na punkty krzywej!), następnie po jej pod-
świetleniu wciśnij lewy przycisk myszy i przesuń (pociągnij) krzywe ku górze, tak jak na obrazie 5. 
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Obraz 5

•	 Wskaż sąsiadującą z nimi skrajną krzywą i pociągnij ją lekko w dół (obraz 6) – nie zmieniaj para-
metrów w oknie polecenia. 

Obraz 6
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•	 Zaznacz i pociągnij w dół krzywą pokazaną na obrazie 7 – nie zmieniaj parametrów w oknie po-
lecenia. 

Obraz7 

•	 W oknie polecenia wciśnij OK, aby opuścić polecenie X-Form.

Swobodne zmiany kształtu modelu mogą być dokonywane w podobny sposób przy pomocy po-
lecenia I-Form (Edit->Surface). Polecenie to umożliwia edycję kształtu powierzchni z wykorzy-
staniem definiujących ją krzywych izoparametrycznych (obraz 8 i 9). W niniejszym ćwiczeniu pole-
cenie I-Form wykorzystane zostanie do zmiany parametrów powierzchni definiującej czołowe lico 
modelu.

•	 Wybierz Edit->Surface->I-Form.
•	 Zaznacz lico frontowe (kolor czerwony), następnie ustaw parametry zgodnie z obrazem 8. 
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Obraz 8

•	 Pociągnij za środkowy uchwyt krzywej, aby uzyskać wynik zgodny z obrazem 9. Zwróć uwagę 
na tworzące się tzw. grzebienie krzywych niepłaskich, których kształt wynika z charakteru zakrzy-
wienia.

Obraz 9
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•	 Aby zaokrąglić krawędź łączącą modyfikowane lica, wybierz Insert->Detailed Feature-> 
Edge Blend.

•	 Wprowadź zaokrąglenie o promieniu 10 mm zgodnie z obrazem 10.

Obraz 10

Następnym etapem ćwiczenia będzie wykonanie wyciągnięcia narysowanego profilu wzdłuż wek-
tora z wykorzystaniem polecenia Extrude. Wyciągnięcie odzwierciedli fragment obudowy apara-
tu, w której zabudowany będzie jego obiektyw. 

•	 Wybierz Insert->Design Feature->Extrude.
•	 Wskaż tylne lico bryły jako płaszczyznę szkicowania.
•	 Na poziomie szkicownika upewnij się, że opcja Continuous Auto Dimensioning jest wyłączona 

(niepodświetlona).
•	 Naszkicuj profil zbliżony do przedstawionego na obrazie 11. Możesz tutaj wykorzystać informacje 

poznane w ćwiczeniu nr 1.
•	 Wybierz Insert->Geometric Constraints. W  wyświetlonym oknie dialogowym wybierz relację 

równej długości – Equal Length, a następnie zaznacz (bez Ctrl) dwie boczne linie profilu (ob-
raz 11).

•	 W podobny sposób wprowadź relację styczności Tangent pomiędzy liniami a łukiem. 
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Obraz 11

•	 Zakończ szkic, wybierając Finish Sketch (menu Task lub przycisk na pasku Sketch).
•	 Ustaw kierunek (przeciągnij niebieski uchwyt lub użyj przycisku Reverse Direction) i granicę two-

rzonego wyciągnięcia jak na obrazie 12 – w oknie polecenia opcję Boolean ustaw na wariant None. 

Obraz 12
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System NX posiada funkcjonalność wieloobiektowego modelowania bryłowego. Opcja Boolean 
ustawiona na wariant None (brak wykonywania operacji Boole’a  na obiektach bryłowych) jest 
jednym z dostępnych narzędzi umożliwiających tworzenie oddzielnych obiektów bryłowych. Od-
dzielne bryły można w dowolnym momencie połączyć w jeden obiekt bryłowy z wykorzystaniem 
poleceń dostępnych w  Insert->Combine. Połączenie korpusu obudowy i  fragmentu zabudowy 
obiektywu zostanie wykonane w dalszej części ćwiczenia.

W następnych krokach zmodyfikowane zostaną lica boczne obudowy obiektywu z wykorzysta-
niem poznanego już polecenia X-Form. Należy zwrócić szczególną uwagę na fakt, że dzięki na-
rzędziom Technologii Synchronicznej obecnej w NX, możliwa będzie jednoczesna modyfikacja 
dwóch lic, poprzez zmianę tylko jednego z nich. Wbudowana inteligencja systemu NX, polega-
jąca m.in. na automatycznym rozpoznawaniu symetrii lic i synchronicznym wprowadzaniu 
zmian, znacząco przyspiesza proces projektowy, czyniąc go niezwykle intuicyjnym. 

•	 Wybierz polecenie X-Form.
•	 Zaznacz lico zgodnie z obrazem 13, następnie w oknie polecenia zaznacz opcję Use Face Finder. 

Obraz 13

•	 W oknie polecenia w sekcji Face Finder przejdź na zakładkę Reference, następnie ustaw opcję 
Reference na wariant New CSYS i wciśnij przycisk CSYS Dialog (obraz 14).
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Obraz 14

•	 Aby zdefiniować położenie układu odniesienia, kliknij w środkowym punkcie przedniej, prostej 
krawędzi modelu, następnie wciśnij przycisk OK (obraz 15).

Obraz 15

Obraz 16
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•	 Przejdź na zakładkę Results i zwróć uwagę, że system automatycznie wykrywa obiekty syme-
tryczne względem zdefiniowanego układu.

•	 Zaznacz pozycję Symmetric, następnie ustaw pożądaną liczbę punktów na krzywych oraz pozo-
stałe opcje jak na obrazie 16. 

Obraz 16
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•	 Przesuń zaznaczony punkt „w  stronę materiału” zgodnie z  obrazem 17 – zauważ, że zmiana 
kształtu wskazanego lica jest automatycznie odzwierciedlana na licu symetrycznym.

Obraz 17

W celu zwiększenia atrakcyjności wizualnej modelowanego wyrobu, dokonana zostanie konwersja 
górnego planarnego lica obiektywu do powierzchni zakrzywionej.

•	 Uruchom polecenie X-Form, następnie wskaż górne lico (obraz 18). 

Obraz 18



100 Seria wydawnicza CAx dla praktyków

ĆWICZENIE Nr 2

•	 Zgodnie z obrazem 19 ustaw parametry w oknie polecenia, następnie zaznacz krzywą w przedniej 
części obudowy i przesuń ją w dół. 

Obraz 19

•	 Zaznacz dwie środkowe krzywe (trzymając wciśnięty Ctrl) i przesuń je w górę (obraz 20) – nie 
zmieniaj parametrów polecenia.
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Obraz 20

•	 Zaznacz skrajne boczne krzywe i pociągnij je w dół (obraz 21).

Obraz 21



102 Seria wydawnicza CAx dla praktyków

ĆWICZENIE Nr 2

•	 Aby połączyć dwa istniejące obiekty bryłowe, wybierz Insert->Combine->Unite. 
•	 Upewnij się, że w oknie polecenia wyłączone są opcje Keep Target i Keep Tool, następnie za-

znacz w dowolnej kolejności istniejące obiekty bryłowe (korpus obudowy i obudowę obiektywu) 
i wciśnij OK (obraz 22).

 

Obraz 22

•	 W celu wykonania przycięcia obudowy obiektywu, wybierz polecenie Extrude. 
•	 Wskaż boczne płaskie lico obudowy, następnie naszkicuj profil jak na obrazie 23.
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Obraz 23

•	 Dokonaj wycięcia, ustawiając parametry zgodnie z obrazem 24.

Obraz 24
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Następnym etapem pracy nad projektem obudowy aparatu będzie wprowadzenie zaokrągleń na 
wybranych krawędziach bryły. Zapewnią one między innymi „płynne przejście” pomiędzy korpu-
sem aparatu, a obudową obiektywu (obraz 25). 

•	 Za pomocą polecenia Edge Blend wprowadź zaokrąglenia pokazane na obrazach 25 i 26.

Obraz 25

Obraz 26
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Obok kwestii estetyki wyrobu bardzo ważną cechę stanowi jego ergonomia. Przedstawiona po-
niżej zamiana bocznych lic płaskich korpusu w  lica zakrzywione przy użyciu polecenia I-Form, 
zapewni użytkownikowi rzeczywistego wyrobu komfort utrzymywania aparatu w dłoniach.

•	 Uruchom polecenie I-Form i wskaż prawe boczne lico korpusu.
•	 Zgodnie z obrazem 27 ustal parametry polecenia, następnie pociągnij środkowy uchwyt krzywej 

„na zewnątrz bryły”.

Obraz 27

•	 Wykorzystując polecenie X-Form, zmodyfikuj kształt mniejszego lica czołowego, przesuwając 
nieznacznie zaznaczone krzywe „na zewnątrz” bryły (obraz 28). 
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Obraz 28

W poniższej części opracowania przedstawiono kroki prowadzące do utworzenia uchwytu apara-
tu. Do istniejącej bryły dodany zostanie prostopadłościan, który będzie stanowił bazę dla dalszych 
działań stylizacyjnych. 

•	 Za pomocą polecenia Extrude, utwórz prostopadłościan zgodnie z obrazami 29 i 30.
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Obraz 29

Obraz 30
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Pasek narzędziowy Synchronous Modeling oferuje użytkownikowi polecenie Replace Face, 
dzięki któremu może on modyfikować lica obiektu w jeszcze inny sposób, tj. przy wykorzystaniu 
geometrii innych istniejących lic lub powierzchni występujących w modelu. Zabieg taki zostanie 
wykonany w odniesieniu do górnego lica utworzonego przed momentem prostopadłościanu (ob-
raz 31).

•	 Wybierz Insert->Synchronous Modeling->Replace Face (lub pasek Synchronous Modeling).
•	 Zaznacz lico, które będzie modyfikowane: górne płaskie lico prostopadłościanu (kolor zielony).
•	 Zaakceptuj wybór, naciskając rolkę myszy.
•	 Zaznacz lico zastępujące: sąsiadujące krzywoliniowe lico obudowy (kolor różowy).
•	 Ustal odstęp 20 mm (Distance).
•	 Kliknij OK, aby ukończyć operację.

Obraz 31

•	 Używając poznanych wcześniej poleceń X-Form i I-Form, zamodeluj estetyczny i ergonomiczny 
kształt dla części uchwytowej korpusu – postaraj się uzyskać kształt zbliżony do przedstawionego 
na obrazach 32-35.
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Obraz 32

Obraz 33
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Obraz 34

Obraz 35

•	 Przy użyciu polecenia Edge Blend dodaj zaokrąglenia na wybranych krawędziach uchwytu (ob-
raz 36).
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Obraz 36

•	 Raz jeszcze zmodyfikuj geometrię górnego lica uchwytu korpusu, zastępując ją geometrią górne-
go lica należącego do obudowy obiektywu – użyj poznanego wcześniej polecenia Replace Face 
z odstępem 14 mm w dowolnym kierunku (obraz 37).

Obraz 37
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Końcowa faza modelowania obudowy aparatu wymaga wprowadzenia brakujących zaokrągleń 
na ostrych krawędziach. W celu uzyskania efektów przedstawionych na poniższych ilustracjach 
nie są potrzebne żadne specjalizowane polecenia – poznane już polecenie Edge Blend umożliwi 
zamodelowanie wszystkich wymaganych „płynnych przejść”.

•	 Wybierz polecenie Edge Blend i utwórz zaokrąglenia przedstawione na obrazach 38-42.

Obraz 38

Obraz 39
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Obraz 40

Obraz 41
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Obraz 42

Ze względu na wymogi wzornictwa przemysłowego, ergonomii lub technologiczności, może po-
jawiać się potrzeba przemieszczania (przesunięcia lub obrotu) określonych ścian modelu w koń-
cowej fazie projektowania. W takich przypadkach stosuje się tzw. bezpośrednią edycję geometrii 
modelu, która eliminuje konieczność ingerencji w drzewo operacji (żmudna analiza powiązań, błę-
dy przebudowy itd.).

Narzędzia umożliwiające bezpośrednią modyfikację geometrii dostępne są wielu systemach CAD, 
jednak większość z nich ma problemy z edycją geometrii zawierającą zaokrąglenia. Zaokrąglenia 
muszą dynamicznie dopasowywać się do zmian geometrii, a  to z  reguły się nie udaje i zmusza 
użytkowników innych systemów do usuwania istniejących zaokrągleń i/lub dokonywania czaso-
chłonnych zmian w drzewie operacji.

W  NX, dzięki Technologii Synchronicznej i  wbudowanej inteligencji systemu (obecność roz-
wiązań do obsługi zaawansowanych zmian topologii modelu), problem modyfikacji geometrii 
zawierającej zaokrąglenia nie istnieje. W trakcie dokonywania bezpośrednich zmian geometrii 
modelu, istniejące zaokrąglenia są w czasie rzeczywistym poprawnie przeliczane, nawet w bardzo 
skomplikowanych przypadkach.

Opisane powyżej funkcjonalności zostaną w  ćwiczeniu zaprezentowane na przykładzie bezpo-
średniej modyfikacji geometrii obudowy, w celu powiększenia obszaru korpusu przeznaczonego 
na zamocowanie obiektywu.
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•	 Wybierz Insert->Synchronous Modeling-> Move Face.
•	 Zaznacz lico do przeniesienia (kolor pomarańczowy) i ustaw parametry w oknie polecenia zgodnie 

z obrazem 43.
•	 Kliknij w zaznaczoną na ilustracji (czerwona obwiednia) oś narzędzia Orient Xpress, aby zdefinio-

wać kierunek przesunięcia.
•	 Kliknij OK, aby zatwierdzić zmiany i opuścić polecenie.
•	 Zwróć uwagę na poprawne dopasowanie istniejących zaokrągleń.

Obraz 43

•	 Na zakończenie ćwiczenia wykorzystaj poznane polecenia i  samodzielnie wykonaj otwór na 
przedniej ścianie w sposób zbliżony do przedstawionego na obrazie 44.
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Obraz 44

Wykonałeś w  systemie NX model obudowy aparatu fotograficznego, charakteryzujący się no-
woczesnym, ciekawym i oryginalnym kształtem. Zauważ, że proces projektowy nie trwał długo, 
a skomplikowany kształt geometrii uzyskałeś, wykorzystując zaledwie kilka łatwych w użyciu pole-
ceń. Jeśli masz ochotę, spróbuj we własnym zakresie odnaleźć polecenia związane z wizualizacją 
projektu i zmień sposób wyświetlania Twojego modelu.



117Seria wydawnicza CAx dla praktyków

Synchroniczne modelowanie swobodne

Obraz 45
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Modelowanie z wykorzystaniem równania krzywej

Ćwiczenie nr 3:  
MODELOWANIE Z WYKORZYSTANIEM RÓWNANIA KRZYWEJ

Niniejsze ćwiczenie poświęcone jest projektowaniu 3D sprężyny falistej, o kształcie takim, jak po-
kazano na obrazie 1. W  programie NX tego typu złożone kształty można szybko zamodelować 
korzystając z  jednej z  zaawansowanych opcji wykreślania krzywych przestrzennych. Funkcja ta 
umożliwia precyzyjne zamodelowanie krzywej poprzez zdefiniowanie jej równania analitycznego. 

W pierwszym kroku należy utworzyć nowy plik części, w którym zamodelowana zostanie geome-
tria sprężyny.

•	 Uruchom system NX, a następnie na pasku narzędzi Standard wybierz New (obraz 2).
•	 W oknie dialogowym New dokonaj następujących ustawień:

ÔÔ szablon modelowania: pojedyncza część (w obszarze Templates wybierz Model),
ÔÔ ustawienie jednostek: metryczne (Units->Millimeters),
ÔÔwprowadź nazwę tworzonego właśnie pliku NX (.prt), np. law_curve.prt,
ÔÔwybierz lokalizację, w której zapiszesz plik (New File Name->Folder).

Uwaga: W nazwie pliku i nazwach folderów nie używaj polskich znaków!

Obraz 1
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Obraz 2

•	 Wciśnij przycisk OK – zdefiniowany plik NX zostanie otwarty we właściwym środowisku projek-
towym (Modeling).

Wygląd interfejsu programu NX może być w szerokim zakresie zmieniany przez użytkownika i do-
stosowywany do jego potrzeb i preferencji. Dodatkowo każdy wariant ustawień interfejsu można 
zapisać w tzw. Rolach, czyli indywidualnych profilach użytkownika. System NX posiada szereg 
predefiniowanych profili (Ról), dedykowanych dla użytkowników o różnym stopniu zaawansowania 
lub dla różnych branż przemysłu.

Ilustracje w niniejszej instrukcji zostały wykonane w interfejsie programu uzyskanym po włączeniu 
Roli o nazwie Advanced with full menus. Włącz taki profil w swojej instalacji NX.
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•	 Na pionowym pasku narzędzi Resource Bar, znajdującym się po lewej stronie okna graficznego, 
kliknij przycisk Roles.

•	 W zakładce System Defaults kliknij na pozycję Advanced with full menus (obraz 3).

Obraz 3

•	 W oknie informacyjnym Load Role kliknij OK (obraz 4).

Obraz 4

W  NX możliwe jest zwiększenie obszaru okna graficznego poprzez włączenie automatycznego 
ukrywania nieużywanych okien Resource Bar. W tym celu klikamy na „pinezkę” w górnej części 
Resource Bar, zmieniając jej status (obraz 5).
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Obraz 5

Proces modelowania sprężyny falistej rozpoczynamy od narysowania krzywej przestrzennej  
o pożądanym kształcie. Do tego celu wykorzystana zostanie funkcja Law Curve.

•	 W głównym menu kliknij Insert->Curve->Law Curve… (obraz 6).

Obraz 6
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Funkcja Law Curve generuje krzywą na podstawie kombinacji trzech składowych, z których każda 
definiuje jej przebieg w kierunku jednej z trzech osi wskazanego układu współrzędnych. Jeśli układ 
współrzędnych nie zostanie wskazany, krzywa zostanie wykreślona dla bieżącego położenia Ro-
boczego Układu Współrzędnych (WCS – z ang. Work Coordinate System), którego kolorowy 
symbol wyświetlany jest w środkowej części okna graficznego (obraz 7).

Obraz 7

Każda ze składowych definiowanego równania krzywej może być określona za pomocą reguł do-
stępnych w oknie dialogowym funkcji.

•	 W oknie dialogowym funkcji Law Curve kliknij na opcję Law Type, aby rozwinąć listę wszystkich 
dostępnych reguł (obraz 8).

Obraz 8
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Ponieważ tworzona w tym ćwiczeniu krzywa ma złożony kształt przestrzenny, w przypadku wszyst-
kich trzech składowych równania wykorzystana zostanie opcja By Equation. Aby ją zastosować, 
konieczne jest wcześniejsze zdefiniowanie odpowiednich formuł dla zmiennych xt, yt i zt. 

•	 W oknie dialogowym Law Curve kliknij Cancel.
•	 W głównym menu kliknij Tools->Expression… (obraz 9).

Obraz 9

•	 W oknie dialogowym Expressions, w polach Name i Formula wpisz nazwę tworzonego para-
metru t oraz jego wartość, jak przedstawiono na obrazie 10. Zwróć uwagę na typ stosowanych 
jednostek.

Obraz 10

•	 Zatwierdź nową zmienną klikając Enter.
•	 W analogiczny sposób utwórz parametr określający skok modelowanej sprężyny (obraz 11).
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Obraz 11

•	 Utwórz parametr określający promień modelowanej krzywej spiralnej (obraz 12).

Obraz 12

•	 Utwórz parametr określający położenie punktu początkowego krzywej na osi Z układu współrzęd-
nych (obraz 13).

Obraz 13

•	 Utwórz parametr definiujący wartość amplitudy „pofalowania” krzywej (obraz 14).

Obraz 14
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•	 Utwórz parametr definiujący liczbę zwojów modelowanej spirali (obraz 15).

Obraz 15

•	 Utwórz parametr określający liczbę „fal” występujących na krzywej (obraz 16).

Obraz 16

•	 Utwórz zmienną definiującą całkowity kąt pomiędzy punktem początkowym, a końcowym gene-
rowanej krzywej (obraz 17).

Obraz 17

•	 Utwórz parametr określający całkowity kąt wykorzystywany do obliczenia pofalowania krzywej  
(obraz 18).

Obraz 18
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•	 Utwórz zmienną definiującą składową xt równania krzywej (obraz 19).

Obraz 19

•	 Utwórz zmienną definiującą składową yt równania krzywej (obraz 20).

Obraz 20

•	 Utwórz zmienną definiującą składową zt równania krzywej (obraz 21).

Obraz 21

•	 Upewnij się, że w oknie Expressions zostały utworzone wszystkie niezbędne zmienne, a następ-
nie kliknij OK (obraz 22).
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Obraz 22

•	 W  głównym menu kliknij Insert->Curve->Law Curve…, a  następnie OK w  oknie dialogowym 
Law Curve.

Dzięki wcześniejszemu zdefiniowaniu formuł opisujących składowe xt, yt i zt, natychmiast po włą-
czeniu funkcji Law Curve pojawia się podgląd generowanej krzywej (obraz 23).
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Obraz 23

Kolejnym krokiem ćwiczenia jest stworzenie zarysu przekroju poprzecznego pręta modelowanej 
sprężyny, który zostanie wyciągnięty wzdłuż stworzonej krzywej. 

•	 W głównym menu kliknij Insert->Sketch In Task Environment… (obraz 24).

Obraz 24
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•	 W oknie dialogowym Create Sketch wybierz typ szkicu On Path, co pozwoli na stworzenie szkicu 
przypisanego do krzywej przestrzennej (obraz 25).

Obraz 25

•	 Zaznacz spiralę, a następnie wpisz wartość 0 w polu % Arc Length (obraz 26). Dzięki temu płasz-
czyzna tworzenia szkicu będzie znajdowała się w punkcie początkowym krzywej

Obraz 26
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•	 Kliknij OK w oknie dialogowym Create Sketch, a zostanie uruchomione środowisko szkicownika 
(Sketch).

•	 Z paska narzędzi Sketch Tools wybierz polecenie Rectangle (obraz 27).

Obraz 27

•	 Narysuj prostokąt o wymiarach 7 mm x 2 mm, rozpoczynając od punktu początkowego spirali  
(obraz 28).

Obraz 28
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•	 Kliknij Finish Sketch, aby zakończyć szkicowanie i powrócić do widoku przestrzennego modelu 
(obraz 29).

Obraz 29

•	 Na pasku narzędzi Surface kliknij na funkcję Swept (obraz 30).

Obraz 30

•	 Zmień ustawienie filtra zaznaczania krzywych na opcję Feature Curves, dzięki czemu możliwe bę-
dzie szybkie zaznaczenie wszystkich krzywych wchodzących w skład utworzonego właśnie szkicu  
(obraz 31).
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Obraz 31

•	 Kliknij na jednym z boków prostokąta. Zauważ, że zaznaczeniu uległy wszystkie odcinki znajdują-
ce się w tym szkicu (obraz 32).

Obraz 32
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•	 Kliknij na Select Curve w zakładce Guides okna dialogowego Swept, a następnie zaznacz krzy-
wą spiralną (obraz 33).

Obraz 33
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•	 W oknie dialogowym Swept, w zakładce Section Options, grupie Orientation Method wybierz 
opcję Vector Direction, a następnie wybierz z listy wektor +ZC (obraz 34).

Obraz 34

•	 Kliknij OK.



138 Seria wydawnicza CAx dla praktyków

ĆWICZENIE Nr 3

•	 Przy pomocy funkcji Show and Hide ukryj wszystkie szkice i krzywe przestrzenne modelu, klika-
jąc na symbol „–” w oznaczonych na ilustracji wierszach (obraz 35).

Obraz 35

Był to ostatni krok tworzenia modelu sprężyny falistej. Model ten jest w pełni parametryczny i dzię-
ki zdefiniowaniu zmiennych sterujących możliwa jest bardzo szybka jego edycja.
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•	 Na pasku Resource Bar kliknij na narzędziu Part Navigator, a następnie rozwiń zakładkę User 
Expressions, w której znajduje się zbiór zmiennych zdefiniowanych przez użytkownika (obraz 36).

Obraz 36

Obraz 37
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•	 Kliknij dwukrotnie na zmiennej n_turn i zmień jej wartość na 12.5. Zatwierdź Enterem i zauważ, 
jak zmieniła się liczba zwojów sprężyny (obraz 37). 

Obraz 37
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Ćwiczenie nr 4:  
MODELOWANIE CZĘŚCI BLASZANEJ

W wielu gałęziach przemysłu powszechnie wykorzystuje się części wykonywane w procesie gięcia 
i tłoczenia blach. System NX dysponuje zestawem narzędzi, które pozwalają na szybkie i wygodne 
projektowanie tego typu elementów. Niniejsze ćwiczenie prezentuje sposób wykorzystania niektó-
rych z tych funkcjonalności do wykonania modelu części blaszanej (obraz 1).

Obraz 1

•	 Uruchom system NX, następnie uruchom polecenie New.
•	 W oknie dialogowym New dokonaj następujących ustawień (obraz 2):

ÔÔ szablon modelowania: część blaszana (w obszarze Templates wybierz NX Sheet Metal),
ÔÔ ustawienie jednostek: metryczne (Units->Millimeters),
ÔÔwprowadź nazwę tworzonego właśnie pliku NX (.PRT), np. wspornik.prt,
ÔÔwybierz lokalizację, w której zapiszesz plik (New File Name->Folder).
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Obraz 2

•	 Wciśnij przycisk OK – utworzony plik NX zostanie otwarty we właściwym środowisku projekto-
wym (w tym przypadku Sheet Metal).

System NX posiada wiele różnorodnych środowisk (modułów), które zostały zintegrowane  
w jedno spójne rozwiązanie. Moduł Sheet Metal przeznaczony jest do tworzenia modeli części 
blaszanych wraz ze wszystkimi cechami charakterystycznymi dla tego typu elementów.

Pierwszym krokiem przed przystąpieniem do modelowania poszczególnych cech detalu będzie 
ustawienie podstawowych parametrów technologicznych tworzonej części, takich jak grubość 
blachy, promień gięcia, współczynnik warstwy obojętnej itp. Zapewni to zachowanie zadanych 
wartości we wszystkich operacjach gięć tworzonych w całym procesie modelowania.
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•	 Z menu Preferences wybierz polecenie NX Sheet Metal…
•	 W  oknie dialogowym ustaw domyślną grubość blachy na wartość 2 mm (Global Parameters 

->Material Thickness) jak na obrazie 3.

Obraz 3

Proces modelowania części blaszanej można rozpocząć na kilka sposobów. W opisywanym przy-
padku pierwszą operacją będzie utworzenie modelu blaszanej płytki, na której w dalszych krokach 
definiowane będą kolejne zagięcia.

•	 Z paska narzędzi NX Sheet Metal wybierz polecenie Tab (obraz 4).

Obraz 4

Obraz 4
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•	 Wskaż płaszczyznę XY pomocniczego układu współrzędnych w celu umieszczenia na niej szkicu 
definiującego zarys tworzonej płytki (obraz 5).

Obraz 5

•	 Po wejściu do Szkicownika kliknij środkowym przyciskiem myszy (MB2) lub naciśnij Esc, aby 
wyłączyć automatycznie wywołaną funkcję Profile.

•	 Z paska narzędzi Sketch Tools wybierz polecenie Rectangle, a następnie w oknie dialogowym 
zaznacz opcję Rectangle Method->From Center (obraz 6).

Obraz 6
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•	 Kliknij na punkt początku układu współrzędnych, a następnie wpisz wartości Width = 60, Height 
= 53, Angle = 0, zatwierdzając je Enterem.

Można zauważyć, że stworzony profil został automatycznie zwymiarowany w  taki sposób, aby 
odebrane były jego wszystkie stopnie swobody. Jeśli nie chcemy, aby program dokonywał tej 
czynności automatycznie, możemy wyłączyć tę funkcjonalność klikając na polecenie Continuous 
Auto Dimensioning (obraz 7). 

Obraz 7

•	 Wyjdź ze szkicownika (Task->Finish Sketch lub MB3 (prawy przycisk myszy)->Finish Sketch).
•	 W oknie dialogowym Tab kliknij OK.

Kolejnym krokiem ćwiczenia jest nadanie stworzonej płytce odpowiedniego kształtu poprzez wy-
konanie wycięcia. Wycięcie można zrealizować na dwa sposoby: poprzez wyciągnięcie proste 
(Extrude) lub jako wycięcie normalne (Normal Cutout). Na tym etapie procesu projektowania 
zastosowane zostanie wycięcie proste.
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•	 Na pasku narzędzi NX Sheet Metal wybierz polecenie Extrude (obraz 8).

Obraz 8

•	 Wskaż górną powierzchnię płytki, aby naszkicować na niej profil wycięcia (obraz 9).

Obraz 9

•	 Po wejściu do szkicownika wyłącz funkcję automatycznego wymiarowania (Pasek narzędzi 
Sketch Tools->Contunuous Auto Dimensioning).

•	 Za pomocą funkcji Profile (włącza się ona automatycznie po wejściu do szkicownika – jeśli nie jest 
aktywna, znajdziesz ją na pasku Sketch Tools) narysujesz poziomy odcinek łączący krawędzie 
płytki. Rozpocznij od punktu na lewej krawędzi (obraz 10). Upewnij się, że wyświetlany jest symbol 
punktu na linii.

•	 Gdy podczas rysowania wyświetlony zostanie symbol relacji kierunku poziomego, naciśnij MB2. 
Dzięki temu wykryta relacja będzie zachowywana niezależnie od położenia kursora (obraz 11).

•	 Kliknij na punkt leżący na prawej krawędzi płytki (obraz 12), a następnie naciśnij raz MB2, aby 
zakończyć rysowanie tej części profilu.
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Obraz 10			     Obraz 11		        Obraz 12

•	 Korzystając z relacji kierunku poziomego i pionowego narysuj dwa odcinki prostopadłe (obraz 13), 
a następnie wciśnij i przytrzymaj przez chwilę MB1 (lewy przycisk myszy). Zauważ, że zmienił się 
tryb rysowania – z linii na łuk.

•	 Ustaw kursor w taki sposób, aby końcowy punkt tworzonego łuku był wyrównany z początkiem 
pierwszego narysowanego odcinka (obraz 14).

•	 Naciśnij MB1 i gdy funkcja Profile przejdzie ponownie do trybu rysowania linii, dorysuj ostatni 
odcinek profilu (obraz 15).

•	 Naciśnij dwukrotnie MB2 lub Esc, aby zakończyć rysowanie profilu i wyłączyć funkcję Profile.

Obraz 13			   Obraz 14		              Obraz 15
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W kolejnych krokach zostanie określone dokładne położenie profilu za pomocą wymiarów i relacji 
geometrycznych.

•	 Z paska Sketch Tools wybierz polecenie Inferred Dimensions (obraz 16).
•	 Na pasku narzędzi Selection wybierz opcję filtra wyboru Within Work Part Only, aby umożliwić 

zaznaczanie obiektów nie należących do aktywnego szkicu (obraz 17).

Obraz 16				        Obraz 17

•	 Kliknij na dolną poziomą linię i  górną krawędź płytki. W  okienku wymiaru wprowadź wartość 
40 mm i zatwierdź naciskając Enter.

•	 Kliknij na krótką pozioma linię i nadaj jej długość 10 mm, a następnie w ten sam sposób zmień 
wartość promienia łuku na 10 mm. Na koniec utwórz wymiar 2,5 mm pomiędzy krótszą pionową 
linią a pionową krawędzią płytki (obraz 18).

Obraz 18
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•	 Z paska Sketch Tools wybierz polecenie Constraints, służące do nadawania relacji geometrycz-
nych (obraz 19).

Obraz 19

•	 W oknie dialogowym Geometric Constraints zaznacz typ relacji Collinear (obraz 20).
•	 Zaznacz górną poziomą linię szkicu, zatwierdź naciskając MB2, a następnie zaznacz górną kra-

wędź płytki (obraz 21), aby uczynić te obiekty współliniowymi (obraz 22). Podczas zaznaczania 
może być konieczna zmiana ustawienia filtra wyboru, jak to miało miejsce podczas nadawania 
wymiarów.

Obraz 20					            Obraz 22

•	 Zamknij okno dialogowe Geometric Constraints.

Obraz 21
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•	 Zaznacz łuk szkicu (obraz 23) i punkt końcowy dłuższej linii poziomej, a następnie kliknij na sym-
bol relacji Point on Curve na pasku narzędzi, który pojawił się w pobliżu kursora (obraz 24). 

Obraz 23							       Obraz 24

W  wyniku nadania wymiarów i  relacji geometrycznych szkic przyjął postać jak na obrazie 25, 
a wszystkie jego stopnie swobody zostały odebrane, o czym informuje komunikat pojawiający się 
na pasku informacyjnym.

Obraz 25
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•	 Zakończ szkicowanie (MB3->Finish Sketch).

Jeśli na podglądzie wyciągnięcie narysowanego profilu nie jest skierowane w  stronę materiału 
płytki, kliknij dwukrotnie strzałkę oznaczoną jako End (obraz 26).

Obraz 26

•	 W oknie dialogowym Extrude wybierz Limits->End->Until Next (obraz 27).

Zauważ, że program automatycznie zastosował opcję usuwania materiału (Substract). W zakład-
ce Boolean możliwy jest też wybór innych opcji, np. dodawania materiału lub uzyskania części 
wspólnej.
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Obraz 27

•	 Naciśnij OK.

Kolejnym krokiem ćwiczenia jest skopiowanie uzyskanego wycięcia przy pomocy funkcji odbicia 
lustrzanego.

•	 Wybierz z  głównego menu polecenie odbicia lustrzanego cechy (Insert->Associative Copy 
->Mirror Feature…).

•	 Zaznacz wycięcie (obraz 28) i kliknij MB2, aby przejść do kroku wskazywania płaszczyzny odbicia.
•	 Wskaż płaszczyznę pomocniczego układu współrzędnych (obraz 29).
•	 Zatwierdź klikając OK lub MB2. Uzyskasz wycięcia rozmieszczone symetrycznie po obu stronach 

płytki (obraz 30).
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Obraz 28 Obraz 29

Obraz 30

W następnym kroku zostanie zdefiniowane pierwsze zagięcie modelowanej części blaszanej.

•	 Z paska narzędzi NX Sheet Metal wybierz polecenie Flange (obraz 31).

Obraz 31

•	 Wskaż krawędź, na której ma powstać zagięcie (obraz 32). 
•	 Jeśli zagięcie nie jest skierowane jak na obrazie 33, w oknie dialogowym zmień jego kierunek za 

pomocą opcji Flange Properties->Reverse Direction.
•	 W oknie dialogowym wpisz wartość Length = 16 mm.

Obraz 31
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Obraz 32					     Obraz 33

Funkcja Flange, poza definiowaniem zagięć o określonej długości, pozwala również na modyfi-
kację ich zarysu. W niniejszym przykładzie wykonane zostanie zagięcie z pochylonymi ściankami 
bocznymi.

•	 W oknie dialogowym rozwiń zakładkę Section i wybierz polecenie Edit Sketch (obraz 34), tak 
aby w środowisku szkicownika ukazał się zarys tworzonego zagięcia, który można modyfikować 
według potrzeb (obraz 35).

                  Obraz 35

•	 Z paska narzędzi Sketch Tools wybierz polecenie Line.
•	 Narysuj odcinek pomiędzy dolnym punktem końcowym pionowej linii (obraz 36), a punktem leżą-

cym na linii poziomej (obraz 37).
•	 Używając polecenia Inferred Dimensions, nadaj wymiar kątowy pomiędzy narysowanym odcin-

kiem a linią pionową i wprowadź wartość 3 (obraz 38).

Obraz 34



159Seria wydawnicza CAx dla praktyków

Modelowanie części blaszanej

Obraz 36			   Obraz 37		          Obraz 38

W celu utworzenia analogicznego obiektu po przeciwnej stronie szkicu zastosujemy funkcję odbi-
cia lustrzanego krzywej.

•	 Z paska narzędzi Sketch Tools wybierz polecenie Mirror Curve (obraz 39).

Obraz 39



160 Seria wydawnicza CAx dla praktyków

ĆWICZENIE Nr 4

•	 Zaznacz narysowany odcinek jako obiekt do skopiowania.
•	 Naciśnij MB2, aby przejść do etapu definiowania linii odbicia (Centerline).
•	 Zaznacz pionową oś układu współrzędnych (obraz 40) i wciśnij OK. Po przeciwnej stronie szkicu 

pojawił się skopiowany obiekt oznaczony symbolem kopii lustrzanej (obraz 41).

Obraz 40						         Obraz 41

•	 Zaznacz dwie pionowe linie szkicu, a  następnie z  kontekstowego paska narzędzi wybierz po-
lecenie Convert to Reference (obraz 42). Linie te będą traktowane w szkicu jako pomocnicze 
elementy konstrukcyjne.

Obraz 42



161Seria wydawnicza CAx dla praktyków

Modelowanie części blaszanej

•	 Z paska narzędzi Sketch Tools wybierz polecenie Quick Trim i wskaż fragmenty linii poziomej 
przeznaczone do odcięcia (obrazy 43-45).

Obraz 43			               Obraz 44			          Obraz 45

•	 Zakończ pracę w szkicowniku (MB3->Finish Sketch) i kliknij OK w oknie dialogowym Flange.
•	 Zauważ, że boczne ścianki stworzonego zagięcia są pochylone pod zadanym kątem (obraz 46).

Obraz 46

W następnym etapie modelowania tej części blaszanej utworzone zostaną dwa kolejne zagięcia. 
Wykonane zostaną one w jednej operacji przy wykorzystaniu polecenia Contour Flange. Polece-
nie to pozwala na definiowanie wielu sąsiadujących zagięć jednocześnie.
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•	 Z paska narzędzi NX Sheet Metal wybierz polecenie Contour Flange (obraz 47).

Obraz 47

•	 Wskaż krawędź, na której ma powstać zagięcie (obraz 48). 

Obraz 48

•	 W oknie dialogowym Create Sketch, w zakładce Plane Location wpisz wartość %Arc Length = 0. 
Spowoduje to przesunięcie tworzonej płaszczyzny szkicu do punktu początkowego zaznaczonej 
krawędzi (obraz 49).
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Obraz 49

•	 Kliknij dwukrotnie na osi Z układu współrzędnych znajdującego się na edytowanej płaszczyźnie 
(obraz 50), aby był on zorientowany jak na obrazie 51.

Obraz 50					        Obraz 51

•	 Naciśnij OK, aby przejść do tworzenia szkicu definiującego zagięcia.
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•	 Za pomocą włączonej automatycznie funkcji Profile narysuj dwa odcinki, jak pokazano na ob-
razach 52-55, wpisując z klawiatury wartości długości kolejnych elementów. Zakończ rysowanie 
klikając MB2.

Obraz 53		           Obraz 54				    Obraz 55

•	 Zakończ szkic (MB3->Finish Sketch).

Obraz 52
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•	 Jeśli nie pojawił się podgląd tworzonego zagięcia, kliknij dwukrotnie na grocie strzałki Width, aby 
zmienić jej kierunek i uzyskać efekt jak na obrazie 56.

Obraz 56

•	 Ponieważ zagięcie ma być utworzone na całej długości krawędzi, w  oknie dialogowym zmień 
opcję Width Option na To End (obraz 57).

Obraz 57

Obraz 57
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•	 Zakończ operację klikając OK lub MB2.

W kolejnym kroku wykonane zostanie zagięcie istniejącego fragmentu blachy wzdłuż zdefiniowa-
nej przez użytkownika linii gięcia. 

•	 Z paska narzędzi NX Sheet Metal wybierz polecenie Bend (obraz 58).
•	 Zaznacz ściankę modelu, na której zdefiniowana będzie linia gięcia (obraz 59).

Obraz 58					              Obraz 59

•	 Za pomocą funkcji Line narysuj poziomy odcinek o długości 10 mm, zlokalizowany w przybliżeniu 
jak na obrazie 60.

•	 Włącz funkcję Inferred Dimensions i nadaj wymiar równy 10 mm pomiędzy narysowanym odcin-
kiem a poziomą osią układu współrzędnych (obraz 61).

Obraz 60				             Obraz 61

•	 Zakończ funkcję wymiarowania naciskając MB2.
•	 Zaznacz punkt początku układu współrzędnych oraz narysowany odcinek, a następnie kliknij na 

symbolu relacji Midpoint, znajdującym się na kontekstowym pasku narzędzi (obraz 62).
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•	 Zauważ, że w wyniku tej operacji punkt środkowy odcinka został wyrównany do punktu począt-
kowego układu współrzędnych (obraz 63).

Obraz 62			         Obraz 63

•	 Zakończ szkic (MB3->Finish Sketch).
•	 Upewnij się, że wektor kierunku bazowego funkcji Bend jest skierowany jak na obrazie 64.

Obraz 64

•	 W oknie dialogowym Bend odznacz opcję Extend Section, odpowiedzialną za rozszerzenie linii 
gięcia na całą szerokość blachy (obraz 65). Uzyskasz w ten sposób zagięcie o szerokości zdefi-
niowanej długością narysowanej linii gięcia (obraz 66).
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Obraz 65				    Obraz 66

•	 W oknie dialogowym Bend, w zakładce Relief, zmień opcję Bend Relief na Round (obraz 67), aby 
uzyskać podcięcia o zaokrąglonych krawędziach (obraz 68).

Obraz 67				    Obraz 68

•	 Kliknij OK, aby zakończyć działanie funkcji Bend.
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Główne wymiary stworzonego zagięcia można łatwo edytować wykorzystując funkcję przywołują-
cą wymiary szkicu do przestrzeni 3D modelu.

•	 Kliknij MB3 na zagięciu i z menu kontekstowego wybierz polecenie Show Dimensions (obraz 69).

Obraz 69

•	 Kliknij dwukrotnie na wymiarze definiującym szerokość zagięcia i zmień jego wartość na 15 (obraz 
70).

•	 Zatwierdź zmianę naciskając MB2, aby uzyskać zagięcie o nowej szerokości (obraz 71).

Obraz 70					     Obraz 71

Obraz 69
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ĆWICZENIE Nr 4

W następnym kroku wykonane zostanie przycięcie fragmentu jednego z  zagięć, aby posiadało 
ono pożądaną szerokość. Tym razem do wycinania wykorzystamy funkcję Normal Cutout, która 
zapewnia zachowanie prostopadłości ścian bocznych blachy powstałych w wyniku cięcia.

•	 Z paska narzędzi NX Sheet Metal wybierz polecenie Normal Cutout (obraz 72).
•	 Zaznacz płaskie lico modelu jako płaszczyznę szkicowania (obraz 73).

Obraz 72				    Obraz 73

•	 Po wejściu do szkicownika wyłącz funkcję automatycznego wymiarowania (Pasek narzędzi 
Sketch Tools->Contunuous Auto Dimensioning).

•	 Z paska narzędzi Sketch Tools wybierz polecenie Rectangle i narysuj prostokąt jak na obrazie 
74. Zakończ funkcję Rectangle naciskając MB2.

Obraz 74
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•	 Nadaj relację współliniowości pomiędzy pionowym bokiem prostokąta a krawędzią bryły, zazna-
czając uprzednio oba te obiekty (obraz 75).

Obraz 75

•	 Nadaj analogiczną relację dla poziomego boku prostokąta (obraz 76).

Obraz 76
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•	 Nadaj wymiar (Sketch Tools->Inferred Dimensions) równy 37 mm, określający położenie dolne-
go, poziomego boku prostokąta (obraz 77). Zatwierdź naciskając MB2.

Obraz 77

•	 Stwórz odbicie lustrzane prostokąta względem osi pionowej układu współrzędnych (obraz 78).

Obraz 78
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•	 Nadaj wymiar równy 12 mm, określający odległość pomiędzy prostokątami (obraz 79).

Obraz 79

•	 Zakończ szkic (Sketch Tools->Finish Sketch).
•	 W oknie dialogowym Normal Cutout ustaw opcję Limits na pozycję Until Next (obraz 80) i naci-

śnij przycisk OK.

Obraz 80
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Po zdefiniowaniu poszczególnych zagięć możliwe jest ich odgięcie i  ponowne zagięcie w  celu 
wprowadzenia różnego rodzaju operacji pośrednich (otworów, wycięć, przetłoczeń), przechodzą-
cych przez geometrię zagięcia. W niniejszym ćwiczeniu funkcjonalność ta zostanie wykorzystana 
do zdefiniowania przetłoczeń wzmacniających.

•	 Z paska narzędzi NX Sheet Metal wybierz polecenie Unbend (obraz 81).

Obraz 81

•	 Zaznacz ściankę stacjonarną dla edytowanego zagięcia (obraz 82), a następnie wskaż zagięcie 
do rozwinięcia (obraz 83). Po uzyskaniu podglądu (jak na obrazie 84) kliknij OK lub MB2, aby 
zatwierdzić.

Obraz 83

•	 Z paska narzędzi NX Sheet Metal wybierz polecenie Bead (obraz 85).

Obraz 82

Obraz 84
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Obraz 85

•	 Zaznacz płaszczyznę, na której zostanie zdefiniowany przebieg przetłoczeń (obraz 86).
•	 Po wejściu do szkicownika narysuj pionową linię (jak na obrazie 87), a następnie wykonaj jej odbi-

cie lustrzane względem pionowej osi układu współrzędnych.

Obraz 87

•	 Zakończ szkic (MB3->Finish Sketch).

Obraz 86
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•	 W oknie dialogowym Bead ustaw wartość głębokości przetłoczenia Depth = 2 mm, a następnie 
kliknij OK (obraz 88).

Obraz 88

•	 Z paska narzędzi NX Sheet Metal wybierz polecenie Rebend (obraz 89).

Obraz 89

•	 Zaznacz ściankę zagięcia, które zostało wcześniej odgięte (obraz 90), a po uzyskaniu podglądu 
(jak na obrazie 91) zakończ działanie funkcji naciskając MB2 lub OK. Zwróć uwagę, jak przetło-
czenie dodane do modelu dopasowało sie do wykonanego wcześniej zagięcia (obraz 92).
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Obraz 90

Obraz 91					           Obraz 92

W kolejnym kroku w modelu zostanie wykonany otwór. Do tego celu wykorzystana zostanie funk-
cja tworzenia otworów znana z pracy w module Modeling.

•	 Kliknij MB3 w dowolnym miejscu poza obszarem okna graficznego i włącz wyświetlanie paska 
narzędzi Feature (obraz 93).

•	 Z paska Feature wybierz polecenie tworzenia otworów Hole (obraz 94).

Obraz 93				              Obraz 94
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•	 Wskaż ściankę, na której określone zostanie położenie tworzonego otworu (obraz 95).

Obraz 95

W szkicowniku lokalizacja punktu definiującego położenie osi otworu zostanie określona poprzez 
nadanie wymiaru i relacji geometrycznej.

•	 Zamknij okno dialogowe Sketch Point.
•	 Zaznacz oś X układu współrzędnych oraz utworzony punkt, a następnie kliknij symbol relacji Point 

on Curve, znajdujący się na kontekstowym pasku narzędzi (obraz 96).

Obraz 96
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•	 Dodaj wymiar o wartości 10 mm pomiędzy punktem a krawędzią modelu (obraz 97).

Obraz 97

•	 Zakończ szkic (MB3->Finish Sketch).
•	 W oknie dialogowym funkcji Hole zmień wartość średnicy otworu Diameter = 6 mm oraz opcję 

głębokości Depth Limit = Until Next (obraz 98), a następnie naciśnij OK.

Obraz 98
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ĆWICZENIE Nr 4

Moduł modelowania części blaszanych posiada również funkcję służącą do usuwania ostrych kra-
wędzi blachy poprzez ich zaokrąglanie lub fazowanie.

•	 Z paska narzędzi NX Sheet Metal wybierz polecenie Break Corner (obraz 99).

Obraz 99

•	 W zakładce Break Properties okna dialogowego Break Corner wybierz metodę Blend, ustaw 
Radius = 2 mm, a następnie zaznacz dwie krawędzie pokazane na obrazie 100 i naciśnij Apply.

Obraz 100

•	 W oknie dialogowym Break Corner zmień metodę na Chamfer, ustaw Distance = 2 mm, a na-
stępnie kliknij na górne lico, zaznaczając w ten sposób wszystkie ostre krawędzie leżące na jego 
obwodzie (obraz 101). Naciśnij Apply, aby zatwierdzić.
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Obraz 101

•	 Wykonaj analogiczną fazę dla czterech krawędzi pokazanych na obrazie 102.

Obraz 102

•	 W oknie dialogowym Break Corner zmień Distance na wartość 8 mm, a następnie kliknij na lico 
pokazane na obrazie 103 i naciśnij OK.

Obraz 103

Obraz 103



182 Seria wydawnicza CAx dla praktyków

ĆWICZENIE Nr 4

Na tym etapie proces modelowania części blaszanej został zakończony. W kolejnym kroku wy-
konane zostanie rozwinięcie tej części, które jest niezbędne w procesie produkcyjnym tego typu 
wyrobów.

•	 Z paska narzędzi NX Sheet Metal wybierz funkcję Flat Solid (obraz 104) i wskaż poziomą ściankę 
modelu jako lico stacjonarne (obraz 105).

Obraz 104			              Obraz 105

•	 	Kliknij OK, aby ukazał się model 3D rozwinięcia (obraz 106).

Obraz 106

•	 W oknie Part Navigator kliknij MB3 na nagłówku kolumny Name i wyłącz tryb Timestamp Or-
der, aby mieć możliwość włączania/wyłączania wyświetlania stworzonego właśnie rozwinięcia 
(obraz 107).
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Obraz 107

•	 Aby ukryć model części i wyświetlić tylko model rozwinięcia, kliknij na czerwony znacznik przy 
pozycji Model->Solid Body „SB Tab (1)” (obraz 108).

Obraz 108

•	 Z paska narzędzi NX Sheet Metal wybierz funkcję Flat Pattern (obraz 109).

Obraz 109

Obraz 109
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ĆWICZENIE Nr 4

•	 Zaznacz opcję Move to Absolute CSYS i wskaż poziomą ściankę modelu (obraz 110).

Obraz 110

•	 Kliknij OK. Pojawi się komunikat o utworzeniu dodatkowego widoku zawierającego obraz rozwi-
nięcia (obraz 111).

Obraz 111

•	 W oknie Part Navigator rozwiń zakładkę Model Views i  kliknij dwukrotnie na pozycji „FLAT-
-PATTERN#1”. W oknie graficznym pojawi się widok rozwinięcia z oznaczeniem poszczególnych 
gięć (obraz 112).

Obraz 112
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Utworzony w ten sposób widok może zostać wykorzystany podczas tworzenia dokumentacji tech-
nicznej 2D zamodelowanej części blaszanej (obraz 113). Szczegóły dotyczące pracy z dokumenta-
cją techniczną w module Drafting zostaną przedstawione w kolejnych wydaniach ćwiczeń.

Obraz 113
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Ćwiczenie nr 5:  
MODELOWANIE CZĘŚCI DEFORMOWALNEJ

Niniejsze ćwiczenie poświęcone jest projektowaniu 3D części deformowalnych, czyli takich, które 
po umieszczeniu w złożeniu będą miały możliwość zmiany swojego kształtu i/lub rozmiaru. Z sy-
tuacją taką można się spotkać w przypadku takich elementów maszynowych jak: sprężyny, prze-
wody elastyczne czy też uszczelnienia, które muszą być dopasowywane do istniejącej struktury 
złożenia. Wykonując kroku po kroku poniższe ćwiczenie, użytkownik pozna narzędzia związane 
z modelowaniem sprężyn, definiowaniem części deformowalnej i wykorzystaniem jej w środowisku 
złożenia.

Podstawowym zadaniem tego ćwiczenia jest wykonanie modelu 3D sprężyny stożkowej i zdefinio-
wanie jej jako części deformowalnej, tak aby w złożeniu można było dostosowywać jej rozmiar do 
aktualnych potrzeb (obraz 1).

Obraz 1

Pracę rozpoczynamy od utworzenia nowego pliku części, w  którym zamodelujemy geometrię 
sprężyny.
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ĆWICZENIE Nr 5

•	 Uruchom system NX, a następnie na pasku narzędzi Standard wybierz New (obraz 2).
•	 W oknie dialogowym New dokonaj następujących ustawień:

ÔÔ szablon modelowania: pojedyncza część (w obszarze Templates wybierz Model),
ÔÔ ustawienie jednostek: metryczne (Units->Millimeters),
ÔÔwprowadź nazwę tworzonego właśnie pliku NX (.prt), np. sprezyna_deformowalna.prt,
ÔÔwybierz lokalizację, w której zapiszesz plik (New File Name->Folder).

Uwaga: W nazwie pliku i nazwach folderów nie używaj polskich znaków!

Obraz 2

•	 Wciśnij przycisk OK – zdefiniowany plik NX zostanie otwarty we właściwym środowisku projek-
towym (Modeling).

Wygląd interfejsu programu NX może być w szerokim zakresie zmieniany przez użytkownika i do-
stosowywany do jego potrzeb i preferencji. Dodatkowo każdy wariant ustawień interfejsu można 
zapisać w tzw. Rolach, czyli indywidualnych profilach użytkownika. System NX posiada szereg 
predefiniowanych profili (Ról), dedykowanych dla użytkowników o różnym stopniu zaawansowania 
lub dla różnych branż przemysłowych.
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Ilustracje w niniejszej instrukcji zostały wykonane w interfejsie programu uzyskanym po włączeniu 
Roli o nazwie Advanced with full menus. Włącz taki profil w swojej instalacji NX.

•	 Na pionowym pasku narzędzi Resource Bar, znajdującym się po lewej stronie okna graficznego, 
kliknij przycisk Roles.

•	 W zakładce System Defaults kliknij na pozycję Advanced with full menus (obraz 3).

Obraz 3

•	 W oknie informacyjnym Load Role kliknij OK (obraz 4).

Obraz 4

W  NX możliwe jest zwiększenie obszaru okna graficznego poprzez włączenie automatycznego 
ukrywania nieużywanych okien Resource Bar. W tym celu klikamy na „pinezkę” w górnej części 
Resource Bar, zmieniając jej status (obraz 5).

Obraz 5
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Proces modelowania sprężyny rozpoczynamy od narysowania spirali o pożądanych parametrach.

•	 W głównym menu kliknij Insert->Curve->Helix… (obraz 6).

Obraz 6

•	 W oknie Helix kliknij przycisk CSYS Dialog znajdujący się w zakładce Orientation (obraz 7).

Obraz 7

W  programie NX spirala domyślnie tworzona jest w  taki sposób, że jej oś jest równoległa do 
osi Z roboczego układu współrzędnych (WCS), a początek tej osi znajduje się w punkcie zerowym 
tego układu. W oknie dialogowym CSYS (obraz 8) możliwe jest również wykorzystanie jako układu 
odniesienia układu bezwzględnego lub wskazanego układu pomocniczego.
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Obraz 8

W niniejszym przykładzie zobaczymy, w jaki sposób można szybko zmieniać orientację tworzonej 
spirali poprzez modyfikację położenia układu roboczego.

•	 Przy pomocy uchwytu obróć układ współrzędnych o wartość 90 stopni wokół osi XC, jak poka-
zano na obrazie 9.

Obraz 9

•	 Kliknij OK w oknie dialogowym CSYS.

Po zdefiniowaniu orientacji w oknie graficznym programu pojawia się podgląd spirali o domyślnych 
wartościach parametrów (obraz 10). W kolejnych krokach ustawione zostaną wartości parametrów 
zapewniające uzyskanie pożądanego kształtu i gabarytów spirali.
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Obraz 10

•	 W oknie dialogowym Helix (obraz 11), w zakładce Pitch, ustaw metodę definicji skoku spirali (Law 
Type =Constant) i wpisz jego wartość (Value = 12).

•	 W tym samym oknie, w zakładce Length, wybierz metodę definicji długości spirali (Method = 
Turns) i wpisz wartość liczby zwojów (Turns = 8).

Obraz 11

•	 W zakładce Size (obraz 12), wybierz metodę definicji średnicy spirali (Law Type = Linear) i wpisz 
wartość początkową (Start Value = 80) i wartość końcową (End Value = 40).

Obraz 12
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•	 Kliknij OK w oknie dialogowym Helix.

Wynikiem wykonanej właśnie operacji jest spirala o zadanych parametrach i orientacji (obraz 13).

Obraz 13

Jeśli widok stworzonej geometrii jest zbyt duży lub za mały, możesz szybko dopasować go do 
rozmiaru ekranu, korzystając z funkcji Fit dostępnej m.in. w menu radialnym.

•	 Umieść kursor w dowolnym miejscu tła okna graficznego, a następnie naciśnij i przytrzymaj prawy 
przycisk myszy.

•	 W pojawiającym się menu radialnym skieruj kursor w kierunku wybranej funkcji, w tym przypadku 
w lewy, dolny róg (obraz 14).

Obraz 14

W kolejnym kroku na podstawie wykonanej wcześniej spirali stworzony zostanie model bryłowy 
sprężyny. Ponieważ modelowana sprężyna ma być wykonana z pręta o przekroju kołowym, do 
tego celu zostanie wykorzystana funkcja Tube, służąca do modelowania prętów i rur.

•	 Polecenie Tube można uruchomić korzystając z menu Insert->Sweep->Tube… (obraz 15).
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Obraz 15

Jeśli chcemy szybko odnaleźć tę samą funkcję na pasku narzędzi, możemy skorzystać z funkcji 
Command Finder.

•	 Na pasku narzędzi Standard kliknij Command Finder (obraz 16).

Obraz 16

•	 W oknie dialogowym Command Finder, w polu Search, wpisz „tube” i naciśnij Enter.

Program wyszuka wszystkie funkcje związane z wpisanym słowem i wyświetli informację o  ich 
położeniu w menu i na paskach narzędzi (obraz 17). W opisywanym przypadku możemy zauważyć, 
że funkcja Tube jest obecnie niedostępna na pasku narzędzi, o czym świadczy opis „currently 
hidden”. Wynika to z domyślnych ustawień bieżącej konfiguracji interfejsu (Roli). Możemy jednak 
w łatwy sposób przywołać potrzebną nam funkcję na pasek narzędzi.
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Obraz 17

•	 Kliknij prawym przyciskiem myszy na pozycji Tube na liście wyników i wybierz polecenie Show on 
Toolbar, a funkcja Tube pojawi się na pasku narzędzi Surface (obraz 18).

Obraz 18

•	 Kliknij OK w oknie dialogowym Command Finder.

Przystępujemy do tworzenia modelu bryłowego sprężyny:

•	 Kliknij Tube na pasku narzędzi Surface.
•	 Zaznacz narysowaną wcześniej spiralę i wpisz wartość średnicy zewnętrznej Outer Diameter = 8 

(obraz 19).
•	 Kliknij OK, a na ekranie pojawi się model bryłowy sprężyny.
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Obraz 19

W kolejnym kroku tego ćwiczenia dokonamy operacji na parametrach modelu, tak aby sterować 
rozmiarem sprężyny poprzez określenie jej długości.

•	 W menu głównym kliknij Tools->Expression… (obraz 20).

Obraz 20

•	 W oknie dialogowym Expressions rozwiń listę w polu Listed Expressions i wybierz opcję All, aby 
wyświetlić wszystkie parametry znajdujące się w bieżącym pliku (obraz 21).
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Obraz 21

•	 W polu Name wpisz słowo „dlugosc” (pamiętając o nie stosowaniu polskich znaków), a w polu 
Formula liczbę „96”, a następnie kliknij na przycisk zatwierdzenia (obraz 22).

Obraz 22

Na liście parametrów pojawił się nowy parametr o nazwie „dlugosc”, który wykorzystany zostanie 
do sterowania parametrami definiującymi spiralę (obraz 23).

Obraz 23 

•	 Na liście parametrów zaznacz parametr p3, odpowiedzialny za skok spirali, a następnie w polu 
Formula usuń występującą tam wartość i wpisz literę „d”.

•	 Z pojawiającej się listy funkcji i parametrów, których nazwy rozpoczynają się na literę „d”, wybierz 
parametr „dlugosc” (obraz 24).
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Obraz 24

•	 W edytowanej formule dopisz znak „/”, a następnie kliknij dwukrotnie na parametrze „p13”, aby 
wprowadzić do formuły nazwę parametru odpowiedzialnego za liczbę zwojów spirali. Na koniec 
kliknij na znacznik zatwierdzenia (obraz 25).

Obraz 25

Otrzymaliśmy sytuację, w której parametr skoku spirali jest uzależniony od wartości parametru 
„dlugosc” (obraz 26).

Obraz 26
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Przystępujemy teraz do procesu definiowania stworzonego modelu jako części deformowalnej.

•	 Kliknij w menu Tools->Define Deformable Part (obraz 27).

Obraz 27

•	 W oknie kreatora Define Deformable Part, w kroku Definition, wpisz nazwę dla tworzonej części 
deformowalnej i kliknij Next (obraz 28).
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Obraz 28

•	 W kroku Features wskaż, które cechy modelu mają ulegać zmianom podczas deformacji. Na 
liście Features in Part zaznacz operację Helix(1).

•	 Zaznacz opcję Add Children Features, a następnie kliknij na strzałkę, aby przenieść wskazane 
operacje do kolumny Features in Deformable Part (obraz 29).

Obraz 29



203Seria wydawnicza CAx dla praktyków

Modelowanie części deformowalnej

•	 Przejdź do kolejnego kroku, klikając Next (obraz 30).

Obraz 30

•	 W  kroku Expressions definiujemy, które parametry modelu mogą zmieniać wartości podczas 
deformacji i w jakim zakresie (obraz 31).

ÔÔNa liście Available Expressions zaznacz parametr dlugosc=96 (1), a następnie kliknij na strzał-
kę (2), aby dodać go do listy Deformable Input Expressions.
ÔÔW oknie poniżej możesz opcjonalnie zmienić wyświetlaną nazwę parametru (3).
ÔÔW oknie Expression Rules wybierz opcję By Whole Number Range (4), a następnie wpisz 
wartości graniczne dla definiowanego zakresu zmian parametru (5).
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Obraz 31

•	 W kroku References, służącym do definiowania obiektów odniesienia, kliknij Next (obraz 32).

Obraz 32

•	 W  kroku Summary możesz zweryfikować dotychczasowe działania związane z  definiowaniem 
części deformowalnej. Jeśli stwierdzisz, że wszystkie parametry zostały wprowadzone prawidło-
wo, kliknij Finish (obraz 33).
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Obraz 33

W ten oto sposób zamodelowana wcześniej sprężyna została zdefiniowana jako część deformo-
walna. O tym, że dany model jest traktowany jako część deformawalna świadczy nowa pozycja 
w historii modelowania.

•	 Na pasku Resource Bar kliknij na przycisk Part Navigator i zauważ nową operację w drzewie 
historii modelowania (obraz 34).
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Obraz 34

•	 Kliknij Save na pasku narzędzi Standard, aby zapisać zmiany dokonane w pliku (obraz 35).

Obraz 35

W kolejnym etapie tego ćwiczenia przedstawiony zostanie sposób wykorzystania zamodelowanej 
części deformowalnej w środowisku złożenia. W pierwszym kroku należy utworzyć nowy plik zło-
żenia.

•	 Na pasku narzędzi Standard kliknij New (obraz 36).

Obraz 36
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•	 W oknie dialogowym New dokonaj następujących ustawień (obraz 37):
ÔÔ szablon modelowania: złożenie (w obszarze Templates wybierz Assembly),
ÔÔ ustawienie jednostek: metryczne (Units->Millimeters),
ÔÔwprowadź nazwę tworzonego właśnie pliku NX (.prt) lub pozostaw nazwę domyślną tj. assem-
bly1.prt,
ÔÔwybierz lokalizację, w której zapiszesz plik (New File Name->Folder).

Obraz 37

•	 Kliknij OK.

Program NX utworzył nowy plik o rozszerzeniu takim samym jak w przypadku pliku części. Wynika 
to z faktu, że złożenia tworzy się w tym samym środowisku, co części (Modeling), mając włączony 
w  tle moduł Assemblies. Ponieważ skorzystaliśmy z odpowiedniego szablonu, moduł Assem-
blies włączył się automatycznie. 

W innym przypadku należy sprawdzić, czy moduł Assemblies jest aktywny.
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•	 Na pasku narzędzi Standard kliknij Start i sprawdź, czy moduł Assemblies jest zaznaczony (ob-
raz 38).

Obraz 38

Użycie szablonu Assembly spowodowało także, że automatycznie została włączona funkcja do-
dawania nowego komponentu do złożenia. Dzięki niej wstawimy utworzoną wcześniej sprężynę do 
złożenia jako jego komponent.

•	 W oknie dialogowym Add Component, w zakładce Loaded Parts, zaznacz nazwę pliku do wsta-
wienia (sprezyna_deformowalna.prt) (obraz 39).

•	 W zakładce Placement wybierz metodę pozycjonowania Positioning->Absolute Origin.
•	 Kliknij OK.
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Obraz 39

W  wyniku tej operacji powstało złożenie zawierające komponent w  postaci sprężyny. Program 
automatycznie wykrywa, że jest to część deformowalna i wyświetla okno dialogowe umożliwiające 
wprowadzenie deformacji.

•	 W oknie dialogowym deformacji, w pozycji „dlugosc”, wpisz wartość 75 lub przesuń suwak w od-
powiednie położenie i kliknij OK (obraz 40).



210 Seria wydawnicza CAx dla praktyków

ĆWICZENIE Nr 5

Obraz 40

Część deformowalna może być modyfikowana w złożeniu w dowolnej chwili. 

•	 Na pasku Resource Bar kliknij zakładkę Assembly Navigator.
•	 Kliknij prawym przyciskiem myszy na komponencie „spręzyna_deformowalna” i wybierz polece-

nie Deform… (obraz 41).

Obraz 41
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•	 W oknie dialogowym Deform Component kliknij Edit (obraz 42).

Obraz 42

•	 Przesuń suwak zmiany wartości parametru w lewe skrajne położenie i naciśnij OK (obraz 43).

Obraz 43

•	 W oknie dialogowym Deform Component kliknij OK.

Dzięki funkcjonalności części deformowalnej możliwe jest wprowadzenie do złożenia wielu takich 
samych komponentów i nadanie każdemu z nich innej wartości deformacji.
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•	 Z paska narzędzi Assemblies wybierz polecenie Add Component (obraz 44).

Obraz 44

•	 W oknie dialogowym Add Component zaznacz plik sprężyny, wybierz metodę pozycjonowania 
Select Origin, a następnie kliknij OK (obraz 45).

Obraz 45

Obraz 44
Obraz 45
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•	 Z paska narzędzi Assemblies wybierz polecenie Add Component (obraz 44).

Obraz 44

•	 W oknie dialogowym Add Component zaznacz plik sprężyny, wybierz metodę pozycjonowania 
Select Origin, a następnie kliknij OK (obraz 45).

Obraz 45

Obraz 44
Obraz 45

•	 W oknie dialogowym Point zmień wartość współrzędnej Z = -100 i kliknij OK (obraz 46).

Obraz 46

•	 W oknie dialogowym deformacji ustaw parametr długości na wartość 80 i kliknij OK (obraz 47).

Obraz 47
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W ten sposób w pliku złożenia otrzymaliśmy dwie sprężyny o różnym stopniu ugięcia (obraz 48).

Obraz 48
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Utworzyłeś w systemie NX kilka modeli. Aby uzyskać 
więcej informacji na temat projektowania w NX, śledź 
kolejne wydania Ćwiczeń NX i odwiedzaj regularnie stronę 
internetową www.gmsystem.pl
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